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Preface
Purpose
This guide provides you with the information that you need to install and configure 
Essbase Enterprise Services and Essbase Spreadsheet Services for use with 
Essbase®. This book explains Essbase Enterprise Services features and options 
and contains the concepts, processes, and procedures that you need to use the 
software. 

Audience
This guide is for system administrators and software developers who are 
responsible for installing Essbase Enterprise Services, configuring it, and building 
client programs for use with the product.

Document Structure
This document contains the following information: 

Chapter 1, “Product Overview,” introduces Essbase Enterprise Services features, 
the development platform, and computer resource allocation for the product.

Chapter 2, “Installing Software on Windows Systems,” describes how to install 
Essbase Enterprise Services on Windows systems.

Chapter 3, “Installing Software on UNIX Systems,” describes how to install 
Essbase Enterprise Services on UNIX systems.

Chapter 4, “Configuring and Running Software Components,” describes how to 
configure and run Essbase Enterprise Services servers. This chapter also describes 
how to configure Essbase servers to work with Essbase Enterprise Services 
servers.
� viiEssbase Enterprise Services Installation Guide
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Chapter 5, “Setting up the Sample Programs,” describes how to setup, compile, 
and run the sample client programs provided with Essbase Enterprise Services.

Chapter 6, “System Administration,” outlines how to perform administration and 
maintenance tasks for Essbase Enterprise Services systems.

Chapter 7, “Advanced Installation Topics,” lists locations of essential files and 
describes how to create pointer files, replicate users across a cluster of servers, and 
uninstall the product. 

Glossary contains a list of key terms and their definitions.

Index contains a list of Essbase Enterprise Services terms and their page 
references.

Related Documentation
Hyperion provides the following documentation for this product:

� The online Essbase Enterprise Services Console Help in the Essbase 
Enterprise Services DOCS directory, for more information about using the 
Enterprise Services Console to manage servers and domains.

� The online Essbase Enterprise Services JAPI Reference in the Essbase 
Enterprise Services DOCS directory, for more information about using the 
Essbase Enterprise Services Java application programming interface (JAPI).

� The online Essbase.properties Reference in the Essbase Enterprise Services 
DOCS directory, for more information about using the settings of the 
essbase.properties configuration file.

� The Hyperion Essbase Database Administrator’s Guide, for more information 
about configuring and using Essbase OLAP servers.

Online Help

➤ To access online help:

1. In the installation directory for Essbase Enterprise Services, locate the 
viewDocs.cmd file in the bin subdirectory.

2. Run the viewDocs.cmd file to display the online help.
viii � Essbase Enterprise Services Installation Guide
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➤ To print an online help topic, display the topic and select File > Print. 

To enable viewing of online documentation from the Help menu of Essbase 
Enterprise Services Console on UNIX Systems, see Chapter 3, “Installing 
Software on UNIX Systems”.

Online Guides
The online guides are electronic versions of the printed documentation.

➤ To display an online guide: 

1. In the installation directory for Essbase Enterprise Services, locate the 
viewDocs.cmd file in the bin subdirectory.

2. Run the viewDocs.cmd file to display the online help.

Conventions
The following table shows the conventions used in this document:

Table i: Conventions Used in This Document 

Item Meaning

➤ Arrows indicate the beginning of a procedure consisting 
of sequential steps.

Brackets [] In examples, brackets indicate that the enclosed 
elements are optional.

Bold Bold text indicates words or characters that you type 
exactly as they appear on the page. Bold in procedural 
steps highlights major interface elements.

CAPITAL LETTERS Capital letters denote commands and various IDs. 
(Example: CLEARBLOCK command)

Example text Courier font indicates that the material shown is a code 
or syntax example.
� ixEssbase Enterprise Services Installation Guide
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Additional Support
In addition to providing the documentation and online help, Hyperion offers the 
following support for product information.

Ordering Documentation
A complete set of documentation is included with the product in PDF or HTML 
format. For more information on how to order printed documentation, refer to the 
Documentation Catalog that was shipped with this product, or contact your local 
support office.

Ctrl + 0 Keystroke combinations shown with the plus symbol 
(+) indicate that you should press the first key and 
hold it while you press the next key. Do not type 
the + symbol.

Courier italics Courier italic text indicates a variable field in command 
syntax. Substitute a value in place of the variable shown 
in Courier italics.

Italics Italics in a product-related term in the body of a book 
indicates that the term is also included in the glossary of 
the book.

Ellipses (...) Ellipsis points indicate that text has been omitted from 
an example.

Mouse orientation This document provides examples and procedures using 
a right-handed mouse. If you use a left-handed mouse, 
adjust the procedures accordingly.

Menu options Options in menus are shown in the following format: 
Menu name > Menu command > Extended menu 
command 

For example: File > Desktop > Accounts

n, x The variable n indicates that you must supply a generic 
number; the variable x indicates that you must supply a 
generic letter.

Table i: Conventions Used in This Document (Continued)

Item Meaning
x � Essbase Enterprise Services Installation Guide
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Training Services
Hyperion offers a variety of training options, including instructor-led training, 
custom training, and multimedia training. This training covers all Hyperion 
applications and technologies and is geared to end users, administrators, and 
information systems (IS) professionals.

Instructor-led training is delivered in formats and in locations suited to Hyperion’s 
diverse, global customers. Hyperion Authorized Training Centers offer courses 
that they develop, as well as those developed by Hyperion. Custom training—
training on the configured and tailored applications that employees use on the 
job—is another option to enhance user productivity and to ensure smooth 
day-to-day operations. Multimedia training—including computer-based training, 
Web-based training, and interactive distance learning—provides a cost-effective 
means of giving users a hands-on introduction to product features and functions. 
Computer-based training (CBT) provides high-quality interactive training at the 
user’s convenience, regardless of location.

For more information about training, contact your local training services 
representative. 

Consulting Services
Hyperion Consulting Services assists customers in maximizing the use of, and the 
return on investment in, Hyperion products. Experienced Hyperion consultants 
and Hyperion Alliance Partners assist organizations in tailoring solutions to their 
particular requirements, such as reporting, analysis, modeling, and planning. 
Specific services include implementation consulting, custom business solutions, 
data integration, and technical consulting. Additionally, Hyperion offers a variety 
of Services Packages and Reviews.

For more information about Consulting Services, Services Packages, and 
Reviews, as well as the services offered by Alliance Partners, contact your 
local consulting services representative.

Technical Support
Hyperion provides telephone and Web-based support to ensure that clients resolve 
product issues quickly and accurately. This support is available for all Hyperion 
products at no additional cost to clients with a current maintenance agreement. 

For complete information on available support options, visit our Web sites at 
http://www.hyperion.com and http://www.essbase.com.
� xiEssbase Enterprise Services Installation Guide
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Chapter
1

Essbase Enterprise Ser
Product Overview
This chapter provides an overview of the Essbase Enterprise Services product, 
including major features, software components, development platform, and 
discusses the allocation of computer resources for a production system. Essbase 
Enterprise Services is a highly flexible software product and development 
technology platform, and it is recommended that you review this chapter in full 
before starting to develop client programs and deploy the product.

This chapter contains the following topics:

� “About Essbase Enterprise Services” on page 13

� “Understanding the Essbase Enterprise Services Development Platform” on 
page 17

� “Allocating Computing Resources for Essbase Enterprise Services” on 
page 21

About Essbase Enterprise Services
Essbase Enterprise Services provides a highly scalable, available, and reliable 
platform for developing large-scale, Web-enabled Essbase applications. Essbase 
Enterprise Services works with Essbase and large-scale Java™ programming 
technology to bring enterprise-level performance and reliability to Essbase 
applications. 
� 13vices Installation Guide
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Figure 1: Essbase System Architecture Overview

The Essbase Enterprise Services platform supports large scale Essbase 
applications by providing the following capabilities:

� Essbase server clustering: Essbase Enterprise Services enables you to group 
sets of Essbase servers running applications with identical databases and use 
them as a single resource in your client programs. Support for server 
clustering enables additional features such as request load balancing and 
failover support.

� Essbase server load balancing: Essbase Enterprise Services servers can 
receive requests to a single Essbase application and distribute requests across 
a cluster of Essbase servers running copies of that application.

� Essbase server failover support: Essbase Enterprise Services detects Essbase 
service interruptions in a cluster and automatically reroutes requests to other 
available Essbase servers.
14 � Essbase Enterprise Services Installation Guide
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� Essbase server connection pooling: Essbase Enterprise Services enables 
client requests to share connections, conserving software and network 
resources and improving performance.

For an overview of the Essbase Enterprise Services technology platform, see 
“Understanding the Essbase Enterprise Services Development Platform” on 
page 17.

Software Components
Essbase Enterprise Services requires two software components that are not 
included with the product: Enterprise Services must be connected to Essbase and 
you must have Java API client programs to run against the Enterprise Services 
server. You must purchase Essbase separately and develop the client programs 
using the Java programming language and the Essbase Java API. The relationship 
between the various Essbase and Essbase Enterprise Services components is 
shown in Figure 2. The communication between Essbase Enterprise Services and 
the Essbase cube is through TCP/IP by default. Optional protocols are described 
in this chapter.

Figure 2:  Essbase Enterprise Services System

The client program is a custom-developed Java program that uses the Essbase 
JAPI to request data from Essbase applications.

Essbase is a multidimensional database server for business analysis. Essbase 
Enterprise Services is designed to provide the services of Essbase servers in a 
distributed, highly scalable way. 
1
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Essbase Enterprise Services acts as a broker for client program requests to Essbase 
servers.  The Essbase Enterprise Services product family has four major 
components:

� Essbase Enterprise Services Server, which acts as a gateway for Essbase 
requests and provides user authentication, load balancing, failover support, 
event handling, and messaging services.

� Essbase Enterprise Services Console, which is a program for administering 
Enterprise Services servers, Essbase servers, user accounts, and security 
information.

� Essbase Enterprise Services Command Shell, which is a command-line 
interface for administering Enterprise Services domains, Essbase servers, user 
accounts, and security information. 

� Essbase JAPI, which provides Java programming interfaces for developing 
custom, Web-enabled programs that use Essbase services.

These components work together with Essbase servers and Essbase Enterprise 
Services client programs to provide the services of the Essbase Enterprise Services 
product.

Product Limitations
Essbase Enterprise Services Release 6.5 focuses on high performance, scalable 
delivery of Essbase data to query and reporting client programs. Given this focus, 
this release of the Essbase Enterprise Services product does not support or has had 
limited testing for certain Essbase services. In addition, testing of this release has 
focused on supporting a limited number of third party software. As a result, not all 
combinations of supported operating systems and third party software have been 
tested.

Essbase Enterprise Services Release 6.5 supports only client programs that read 
data from Essbase databases when they are configured in a cluster. Essbase 
Enterprise Services supports only data changes to Essbase databases that are not 
configured as part of a cluster.
16 � Essbase Enterprise Services Installation Guide
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Understanding the Essbase Enterprise Services 
Development Platform

Essbase Enterprise Services supports four types of software technologies for 
Essbase JAPI client programs: Transfer Control Protocol/Internet Protocol 
(TCP/IP), Hypertext Transfer Protocol (HTTP), Enterprise JavaBeans (EJB), and 
Common Object Request Broker Architecture (CORBA) technologies. When you 
start developing client programs for Essbase Enterprise Services, you must choose 
one of these technologies for your client programs. The client program 
technologies are shown in Figure 3. 

Figure 3: Client Program Technologies

Client programs for Essbase Enterprise Services must be written in Java, either as 
a servlet, applet, stand-alone application, or Enterprise Java Bean (EJB). The type 
of Java program you develop depends on the development technology (TCP/IP, 
HTTP, EJB, or CORBA) you use with Essbase Enterprise Services.

The following sections provide a brief overview of each of these supported 
technologies, along with some of their advantages and disadvantages.
1
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For information about how to configure Essbase Enterprise Services using one of 
these technologies, see Chapter 4, “Configuring and Running Software 
Components.”

TCP/IP Client Programs
Client programs can use TCP/IP to communicate with Essbase Enterprise 
Services. TCP/IP is a well known and widely supported communication protocol 
used for computer to computer communication over the Internet.

Essbase Enterprise Services can be installed either as an executable or as a service 
on Windows NT.  Refer to Chapter 2, “Installing Software on Windows 
Systems.”. 

Figure 4: Java applet client program using TCP/IP

Client programs that use TCP/IP are usually stand-alone Java programs. However, 
these client programs can also run as Java servlets. If the client program uses 
TCP/IP, Essbase Enterprise Services must run as a stand-alone Java program.

Implementations of Essbase Enterprise Services client programs using TCP/IP 
technology have the advantage of using small client programs. Client programs 
using TCP/IP with Essbase Enterprise Services are slightly more difficult to 
program than HTTP clients because they must be able to communicate with the 
Essbase Enterprise Services server using the lower-level TCP/IP communication 
protocol.
18 � Essbase Enterprise Services Installation Guide
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HTTP Client Programs
Client programs can use HTTP to communicate with Essbase Enterprise Services. 
HTTP is a well known and widely supported communication protocol used by 
Web browsers and Web servers to communicate over the Internet.

Client programs that use HTTP are usually Java applets running in a Web browser, 
as shown in Figure 5. However, the client program can also run as a stand-alone 
Java program or servlet. If the client program uses HTTP, Essbase Enterprise 
Services must run as a Java servlet in a Java application server. The Essbase 
Enterprise Services product does not include a Java application server—this 
software must be purchased separately.

Figure 5: Java applet client program using HTTP

Implementations of Essbase Enterprise Services client programs using HTTP 
technology have the advantage of using the lightest client programs. Using an 
HTTP configuration also enables client programs to use Secure Sockets Layer 
(SSL) communication protocols. Client programs using HTTP with Essbase 
Enterprise Services tend to be slower because the HTTP protocol is not optimized 
for software to software communication.

EJB Client Programs
Client programs can use EJB and Remote Method Invocation (RMI) to 
communicate with Essbase Enterprise Services. The RMI protocol is specifically 
designed for Java-to-Java communications and is meant for use within the context 
of Java application servers.
1
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If you use EJB technology, both the client program and Essbase Enterprise 
Services must run as EJBs within a Java application server. The Essbase Enterprise 
Services product does not include a Java application server—this software must be 
purchased separately.

Figure 6: Client Program Using EJB

Implementations of Essbase Enterprise Services client programs using EJB 
technology have the advantage of running both the client and server software in a 
single Java application server context. The disadvantage to this type of 
implementation is that a service interruption in either the client or server 
component can stop the Essbase Enterprise Services system. This problem can be 
addressed by clustering Java application servers; that is, running additional copies 
of the Essbase Enterprise Services client and server on separate, connected Java 
application servers.

CORBA Client Programs
Client programs can use CORBA technology to communicate with Essbase 
Enterprise Services. This strategy requires CORBA Object Request Broker (ORB) 
software, such as Borland™ VisiBroker®, to be present for both the client program 
and the Essbase Enterprise Services server. The Essbase Enterprise Services 
product does not include VisiBroker—this software must be purchased separately.

If a client program uses CORBA, it is usually a Java servlet running in a Java 
application server, communicating with Enterprise Services through Internet 
Inter-Orb Protocol (IIOP), as shown in Figure 7. However, the client program can 
also be a stand-alone Java program or a Java applet. A Java servlet client is the 
most likely use of this configuration, because it enables the creation of thinner, 
20 � Essbase Enterprise Services Installation Guide
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browser-based, end-user client programs. The Essbase Enterprise Services product 
does not include a Java application server—this software must be purchased 
separately.

Figure 7: Java servlet client program using CORBA

Implementations of Essbase Enterprise Services client programs using CORBA 
technology usually provide the fastest performance, depending on the size and 
complexity of the client program logic. In this type of implementation, if the client 
program and the Essbase Enterprise Services server are separated by a security 
firewall, the client program must use tunneling protocols to communicate with 
Enterprise Services servers.

Allocating Computing Resources for Essbase 
Enterprise Services

In planning the deployment of Essbase Enterprise Services as a production system,  
developers and system administrators must answer several questions to properly 
deploy the software on their computers and networks.

� What are the current computing resource requirements and user capacity of 
the Essbase application that will be served by Essbase Enterprise Services?

� What is the projected number of concurrent users for the Essbase Enterprise 
Services system?

� How much concurrent usage can the different components of the Essbase 
Enterprise Services system effectively serve? 
1
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� How much memory and processing power should be devoted to the Essbase 
Enterprise Services servers, Enterprise Services client programs, and Essbase 
servers?

� How much and what type of persistent storage will the Essbase applications 
and the Essbase Enterprise Services servers require?

� Is there enough network bandwidth to handle communications between the 
different components of the new Essbase Enterprise Services system?

Allocating resources for large-scale server applications is a challenging task. It is 
not possible to provide definitive answers to these questions because Essbase 
applications, Essbase Enterprise Services servers, and client programs require 
different resources in every case. However, the following considerations and 
guidelines should help in planning allocation of computing resources to your 
Essbase Enterprise Services system.

Analyzing Essbase Applications
Before beginning the process of allocating resources for an Essbase Enterprise 
Services system, you must first analyze the Essbase application you plan to serve 
with Essbase Enterprise Services. The information obtained from this analysis will 
aid you in allocating resources for the Essbase Enterprise Services system.

➤ To analyze the Essbase application, perform the following general steps:

1. Investigate the current system requirements for the Essbase application you 
will be serving through Essbase Enterprise Services. Make note of the 
following items:

– Processor usage (how many and what type)

– Memory usage while under a sustained load

– Disk space usage

2. Investigate how many concurrent users the application can serve with 
acceptable performance.

The statistics gathered in steps 1 and 2 provide a baseline for scaling your 
application to many more users. Once you understand the resources required to 
serve your Essbase application to a certain number of users, you can use this 
combination of processing power, memory, and disk space as a computing 
resource unit from which to estimate the resources required to serve a larger set of 
users.
22 � Essbase Enterprise Services Installation Guide
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3. Assess whether the Essbase application is optimized for best performance.

Many factors can affect the performance of a Essbase application. Ensuring 
that the Essbase application is designed for best performance will improve the 
overall performance of the Essbase Enterprise Services system. For 
information about optimizing the performance of Essbase applications, see the 
Hyperion Essbase Database Administrator’s Guide.

In your performance analysis, pay particular attention to retrieval 
performance. Since Essbase Enterprise Services Release 6.5 supports 
primarily retrieval operations, performance for these tasks is critical.

4. Make changes to the Essbase application to improve performance.

5. Repeat steps 1 and 2 to reassess the system requirements and concurrent load 
capabilities of the Essbase application.

Concurrent Usage Limits and Considerations
In planning to serve a large number of users, there are some concurrent usage 
limitations to take into consideration. Server software programs typically have 
limitations as to the actual number of concurrent users they can support. Knowing 
these general limitations will help you in planning the number of servers you will 
need to deploy.

CAUTION: The numbers provided in the following section are estimates of 
capacity and are provided for planning purposes only. These estimates do 
not constitute a guarantee of actual capacity, as these numbers vary 
depending on application size, application logic, and hardware limitations. 

In planning capacity for large numbers of users, keep in mind that the total user 
community will typically not use the system at the same time. The standard 
estimate for the percentage of a total user community that will actually be logged 
on and using a large-scale system at any one time is 20%. Thus, to serve a total user 
community of 10,000 users, plan to provide capacity to serve at least 2,000 
concurrent users.

A single Java 2, Enterprise Edition (J2EE)-compliant application server can 
typically handle up to 4000 concurrent users. Concurrent user limitations vary 
depending on the application server vendor. See the documentation for your 
application server for more information.
1
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A single Essbase Release 6.1 server can typically handle between 250 and 500 
concurrent users. Concurrent user limitations for Essbase depend on the size of the 
Essbase application and hardware limitations.

A single Essbase Enterprise Services server can typically handle up to 2000 
concurrent users. Concurrent user limitations for Essbase Enterprise Services 
depend on the size and complexity of the client program logic and hardware 
limitations.

Allocating Processing and Memory Resources
In an Essbase Enterprise Services system, the Essbase OLAP Server consumes the 
largest chunk of processing power and memory. Start your estimates with the 
resource requirements for your Essbase application as a stand-alone system.

CAUTION: The guidelines provided in the following section are estimates 
and are provided for planning purposes only. Actual requirements will vary 
depending on application size, application logic, and hardware limitations. 

To get a rough idea of the amount of processing and memory your Essbase 
Enterprise Services system needs, take the number of concurrent users you need to 
serve with the system and divide it by the number of concurrent users that the 
computer running your Essbase application can effectively handle. This result tells 
you roughly how many computers with your current configuration you need to 
serve your user community.

Tip: If you are unsure of the number of concurrent users your Essbase application can 
handle, assume a maximum of 500 concurrent users

Estimating the computing resources necessary for Essbase Enterprise Services 
servers and your client programs is challenging, because it depends on the 
software technology you choose, the size of your client program code and the 
complexity of its logic. However, as a starting point, assume that Essbase 
Enterprise Services servers requires about one quarter to one third the processing 
power and memory that your Essbase servers need. For Essbase Enterprise 
Services client programs that use a server component to feed requests to Essbase 
Enterprise Services servers, assume these servers will need processing and 
memory resources at least equal to that of your Essbase Enterprise Services 
servers.
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Persistent Storage Considerations
Persistent storage and retrieval of data on hard disks are typically the slowest parts 
of a software system. Software processes that require access to data on hard disks 
typically have the most impact on software performance.

In an Essbase Enterprise Services system, the majority of performance impact 
from hard disk access comes from retrieval of data from Essbase databases. The 
Essbase Enterprise Services server also requires hard disk access for retrieving 
user authentication and server cluster information, but this impact is not as 
significant on system performance.

To minimize the impact of hard disk access on an Essbase Enterprise Services 
system, it is recommended that you store the database files for the Essbase 
applications in a high-speed RAID (Redundant Array of Independent Disks) 
system. This strategy minimizes the performance impact of hard disk access and 
increases the reliability of the Essbase Enterprise Services system.

Assessing Network Bandwidth Requirements
Communications between large-scale server applications are taxing on network 
bandwidth. At the minimum, you should ensure that the computers that make up 
your Essbase Enterprise Services system, including the Enterprise Services 
servers, Essbase servers, and servers running the Essbase Enterprise Services 
client programs have at least 100 megabit connections between each other. Higher 
bandwidth connections and dedicated network connections between the computers 
in your Essbase Enterprise Services system are preferable. In general, the more 
concurrent usage of the system (the more users on the system at once), the more 
network bandwidth is required.
1
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Chapter
2

Essbase Enterprise Ser
Installing Software on 
Windows Systems
This chapter describes the installation procedures for Essbase Enterprise Services 
software (Server, Console, Command Shell, Essbase JAPI, batch files, data files, 
and sample programs) on Windows NT and Windows 2000.

This chapter contains the following topics:

� “Windows System Requirements” on page 28

� “Installing Essbase Enterprise Services on Windows Systems” on page 28

� “Installing Essbase Enterprise Services as a Service on Windows NT” on 
page 33

To complete the installation and run Essbase Enterprise Services after running the 
installation program, see Chapter 4, “Configuring and Running Software 
Components.”

For information about setting up the sample applications for use with Essbase 
Enterprise Services, see Chapter 5, “Setting up the Sample Programs.”
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Windows System Requirements
Essbase Enterprise Services for Windows needs a system that meets specific 
requirements. These requirements are described in Table 1.

Depending on the type of client programs you use with Essbase Enterprise 
Services, additional system and software resources may be required. For more 
information on the types of client programs you can use with Essbase Enterprise 
Services, see Chapter 1, “Product Overview” and Chapter 4, “Configuring and 
Running Software Components.”

Installing Essbase Enterprise Services on 
Windows Systems

The Essbase Enterprise Services installation program performs the following 
operations:

� Copies Essbase Enterprise Services files to the\essbase\ess\ directory (or 
to the directory you specify) on your hard disk

� Installs, if you choose, the Java Runtime Environment to the 
\essbase\ess\jre directory 

Table 1: Essbase Enterprise Services Server Windows System Requirements

Component Requirements

Microprocessor Pentium or higher

RAM 128 MB

Windows version Windows NT 4.0 or Windows 2000

Disk space 50 MB

15 MB for the server software, API, sample 
applications, and documentation

9 MB for the Essbase libraries

26 MB for the Java Runtime Environment

Essbase Release 6.2 or later

Java™ platform Java Runtime Environment version 1.3
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� Copies the Essbase Enterprise Services sample application files to 
the\essbase\ess\samples directory on your hard disk

� Copies the Essbase Enterprise Services documentation files to 
the\essbase\ess\docs directory on your hard disk

� Updates existing directories if you have a previous release of Essbase 
Enterprise Services installed

� Creates the initial default user account with name=system and password=
password. This account is used to build additional user accounts. The 
password of the system account can be changed.

For more information about the directories created and files installed, see 
“Directories Created on Windows Systems” on page 32.

Installation Procedure for Windows Systems
Install Essbase Enterprise Services server software on Windows platforms by 
running the self-extracting installation program that you downloaded from the 
Hyperion Web site.

➤ To install Essbase Enterprise Services software to a computer running Windows 
NT or Windows 2000:

1. Run the .exe file that you downloaded from the Hyperion Web site.

2. Follow the prompts and provide any information requested.

To cancel installation at any time, click the Exit button and then the Exit 
Install button.

3. When prompted, type your license number exactly as it is shown on your 
registration letter. Click Next to continue.  

4. When the Choose Install Folder dialog box is displayed, specify the directory 
where you want to install Essbase Enterprise Services.
2
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The default installation directory is C:\essbase\ess\, as shown in Figure 8. 
Type the name of another directory or click Choose to select a directory. If 
you type the name of a directory that does not exist, the installation program 
creates the directory for you.

Figure 8: Choosing Where to Install Essbase Enterprise Services

5. Click Next to continue.

6. In the Choose Java Virtual Machine dialog box, perform one of the 
following steps:

� If you want to install a copy of Java specifically for Essbase Enterprise 
Services, select Install Sun Java VM specifically for this application.

� If you want Essbase Enterprise Services to use an existing installation of 
Java, select Choose a virtual machine already installed on this 
machine. Then, in the list below this option, select an installation of Java.

If you do not see the installation of Java that you want Essbase Enterprise 
Services to use, click Search For Others to have the installation program 
search for other installations of Java, or click Choose Another to locate 
an installation of Java manually.

7. When you finish selecting an option for Java, click Next in the Choose Java 
Virtual Machine dialog box.

8. In the Choose Install Set dialog box, perform one of the following steps:
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� To install the Essbase Enterprise Services server, client, and the Essbase 
JAPI, select Essbase Enterprise Server and Client.

� To install only the Essbase Enterprise Services client and Essbase JAPI 
files, select Essbase Enterprise Client.

Installing the Essbase Enterprise Services client software separately is useful 
for computers that run an Essbase Enterprise Services client program.

9. In the Choose Install Set dialog box, perform one of the following steps:

� To begin copying files to the hard drive, click Install.

� To revise your choices, click Previous.

� To exit the installation program without making changes, click Exit.

10. In the Install Complete dialog box, shown in Figure 9, perform one of the 
following steps:

� To view the readme.txt file, select View Readme.

Figure 9: Completing Installation of Essbase Enterprise Services

11. Click Next to continue.

12. In the Install Complete dialog box, click Done to complete the installation.
2
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Directories Created on Windows Systems
If you chose to install the Essbase Enterprise Server and Client, the installation 
program creates a directory structure including the following directories:

\essbase\ess\
     bin
     data
     devcorner
     docs
     essolap
     external
     jre
     lib
     samples
     uninstallerdata

The devcorner directory is not installed if you chose to install only the Essbase 
Enterprise Client.

The essenterprise directory contains the subdirectories where the files for 
Essbase Enterprise Services are located. This directory is referred to in later 
chapters as the ESS_ES_HOME directory.

� The bin directory contains the executable program files and server setting 
files for Essbase Enterprise Services.

� The data directory contains a database file which Essbase Enterprise 
Services uses by default to store user names, server names, and other domain 
information.

� The devcorner directory contains documentation for developers using the 
Essbase JAPI and Essbase Enterprise Services.

� The docs directory contains documentation for the Essbase Enterprise 
Services, including the readme.txt file and the Essbase JAPI 
documentation.

� The essolap directory contains a runtime version of Essbase.

� The external directory contains library files from other vendors that support 
Essbase Enterprise Services.

� The jre directory contains a copy of the Java Runtime Environment. This 
directory is present only if you chose to install Java during installation.
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� The lib directory contains library files for Essbase Enterprise Services, 
including versions of the software that run as a Java servlet and an Enterprise 
Java Bean (EJB).

� The samples directory contains sample programs for use with Essbase 
Enterprise Services. For more information about the sample programs, see 
Chapter 5, “Setting up the Sample Programs.”

� The uninstallerdata directory contains information for uninstalling 
Essbase Enterprise Services.

Installing Essbase Enterprise Services as a 
Service on Windows NT

Essbase Enterprise Services can be installed to run as a service under Windows 
NT.  As a service, Essbase Enterprise Services uses the native TCP/IP 
communications protocols.  

The installation of Essbase Enterprise Services as a service is slightly different 
than the standard installation under Windows NT. After performing the standard 
installation on Windows NT, complete the following steps to run Essbase 
Enterprise Services as a service. 

1. Add the following statements to the System path (this example assumes that 
you have installed Java at c:\jdk1.3.1 and installed Essbase Enterprise 
Services at c:\ees): 

� c:\jdk1.3.1\bin;c:\jdk1.3.1\jre\bin\server;c:\ees\bin

2. Add the following statements to the Class path:

� c:\jdk1.3.1\bin;c:\ees\lib\ees_es_server.jar;c:\ees\l
ib\ess_japi.jar;

3. Add the following jar/zip files to the Class path if you are using RDBMS as 
your Domain Storage:

� For DB2 - db2java.zip

� For SQL - JSQLConnect.jar

� For Oracle - classes12.zip

4. Specify the absolute path to the Essbase server in the Essbase.Properties 
file system.arborPath statement. By default the Essbase server is specifed 
by a relative path.
2
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5. Leave the EES executable, EssbaseEnterprise.exe, in the ees/bin 
folder. It is not necessary to put the EES executable in a system directory as is 
often the case with Windows NT services.

6. Restart your machine to effect all the Path and Classpath settings.

7. Register the service: EssbaseEnterprise -i. You will get a message 
stating that “the Essbase Enterprise Services are ready”. 

8. Unregister the service: EssbaseEnterprise -u 

9. After registering the service, go to Start>Control Panel> Services> 
EssbaseEnterprise, to start the service. 

10. The Essbase Enterprise Services are now available through the EES console 
or through the client tools (startcmd.cmd, startgui.cmd, and 
startees.cmd). 
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Chapter
3

Essbase Enterprise Ser
Installing Software on UNIX 
Systems
This chapter describes the installation procedures for Essbase Enterprise Services 
software (Server, Console, Command Shell, Essbase JAPI, batch files, data files, 
and sample programs) on Solaris™.

This chapter contains the following topics:

� “Solaris System Requirements” on page 36

� “Installing Essbase Enterprise Services on UNIX Systems” on page 36

� “Installing Essbase Enterprise Services to Run as a Background Process” on 
page 41

To complete the installation and run Essbase Enterprise Services after running the 
installation program, see Chapter 4, “Configuring and Running Software 
Components.”

For information about setting up the sample applications for use with Essbase 
Enterprise Services, see Chapter 5, “Setting up the Sample Programs.”

Note: This installation process also installs a new instance of the Essbase server for 
use with Essbase Enterprise Services.  Because of  the need to reset environment 
variables, it is recommended that this new instance is used rather than an existing 
instance. If you need to use an existing instance of the Essbase server, you will need 
to copy the library files to the /bin directory of that instance. Alternately, you can set the 
LD_LIBRARY_PATH to identify the library files in the /lib directory or the Essbase server 
that is installed with Essbase Enterprise Services.
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Solaris System Requirements
Essbase Enterprise Services for UNIX requires a system that meets minimal 
hardware and software requirements. Essbase Enterprise Services for Solaris 
requires a system with the following minimal hardware and software 
requirements:

Depending on the type of client programs you use with Essbase Enterprise 
Services, additional system and software resources may be required. For more 
information on the types of client programs you can use with Essbase Enterprise 
Services, see Chapter 1, “Product Overview” and Chapter 4, “Configuring and 
Running Software Components.”

Installing Essbase Enterprise Services on UNIX 
Systems

The Essbase Enterprise Services installation program performs the following 
operations:

� Copies Essbase Enterprise Services files to the /home/essbase/ees 
directory (or to the directory you specify) on your hard disk

Table 2: Essbase Enterprise Services Solaris System Requirements 

Component Requirements

Server platform Sun SPARC or ULTRASPARC machines

Solaris version 7 or 8

Physical memory 128 MB RAM

Disk space 50 MB 

15 MB for the server software, API, sample 
applications, and documentation

9 MB for the Essbase libraries

26 MB for the Java Runtime Environment

Essbase Release 6.2 or later

Java™ platform Java Runtime Environment version 1.3
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� Installs, if you choose, the Java Runtime Environment to the 
/home/essbase/ees/jre directory 

� Copies the Essbase Enterprise Services sample application files to 
the/home/essbase/ees/samples directory on your hard disk

� Copies the Essbase Enterprise Services documentation files to 
the/home/essbase/ees/docs directory on your hard disk

� Creates the initial default user account with name=system and password=
password. This account is used to build additional user accounts. The 
password of the system account can be changed.

� Updates existing directories if you have a previous release of Essbase 
Enterprise Services installed

For more information about the directories created and files installed, see 
“Directories Created on UNIX Systems” on page 39.

Installation Procedure for UNIX Systems
Install Essbase Enterprise Services server software on UNIX platforms by running 
the self-extracting installation program that you downloaded from the Hyperion 
Web site.

Note: The Essbase Enterprise Services installer requires a system with the Java 
Runtime Environment installed and graphical windowing software such as X-Windows 
or Motif. 

➤ To install Essbase Enterprise Services software on a computer running a UNIX 
operating system:

1. Log in using the Essbase Enterprise Services system administrator account. 
For example, log in as admin if you created a user account called admin that 
owns the target installation directory /home/essbase/ees/.

2. Run the installer file that you downloaded from the Hyperion Web site.

On Solaris systems, this file is a .bin file.

3. Follow the prompts and provide any information requested.

To cancel installation at any time, click the Exit button and then the Exit 
Install button.

4. When the Choose Install Folder dialog box is displayed, specify the directory 
where you want to install Essbase Enterprise Services.
3
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The default installation directory is /home/essbase/ees/ as shown in 
Figure 10. Type the name of another directory or click Choose to select a 
directory. If you type the name of a directory that does not exist, the 
installation program creates the directory for you.

Figure 10: Choosing Where to Install Essbase Enterprise Services

5. Click Next to continue.

6. In the Choose Java Virtual Machine dialog box, perform one of the 
following steps:

� If you want to install a copy of Java specifically for Essbase Enterprise 
Services, select Install Sun Java VM specifically for this application.

� If you want Essbase Enterprise Services to use an existing installation of 
Java, select Choose a virtual machine already installed on this 
machine. Then, in the list below this option, select an installation of Java.

If you do not see the installation of Java that you want Essbase Enterprise 
Services to use, click Search For Others to have the installation program 
search for other installations of Java, or click Choose Another to locate 
an installation of Java manually.

7. When you finish selecting an option for Java, click Next in the Choose Java 
Virtual Machine dialog box.

8. In the Choose Install Set dialog box, perform one of the following steps:
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� To install the Essbase Enterprise Services server, client, and the Essbase 
JAPI, select Essbase Enterprise Server and Client.

� To install only the Essbase Enterprise Services client and Essbase JAPI 
files, select Essbase Enterprise Client.

Installing the Essbase Enterprise Services client software separately is useful 
for computers that run a Essbase Enterprise Services client program.

9. In the Choose Install Set dialog box, perform one of the following steps:

� To begin copying files to the hard drive, click Install.

� To revise your choices, click Previous.

� To exit the installation program without making changes, click Exit.

10. Click Next to continue.

11. In the Install Complete dialog box, click Done to complete the installation.

Directories Created on UNIX Systems
If you chose to install the Essbase Enterprise Server and Client, the installation 
program creates a directory structure including the following directories:

/home/essbase/ees/
     bin
     data
     devcorner
     docs
     external
     jre
     lib
     essolap
     samples
     uninstallerdata

The devcorner directory is not installed if you chose to install only the Essbase 
Enterprise Client.

The essenterprise directory contains the subdirectories where the files for 
Essbase Enterprise Services are located. This directory is referred to in later 
chapters as the ESS_ES_HOME directory.

� The bin directory contains the executable program files and server setting 
files for Essbase Enterprise Services.
3
� 39Essbase Enterprise Services Installation Guide



Installing Software on UNIX Systems

ig_eds.book  Page 40  Thursday, June 20, 2002  8:20 PM
� The data directory contains a database file which Essbase Enterprise 
Services uses by default to store user names, server names, and other domain 
information.

� The devcorner directory contains documentation for developers using the 
Essbase JAPI and Essbase Enterprise Services.

� The docs directory contains documentation for the Essbase Enterprise 
Services, including the readme.txt file and the Essbase JAPI 
documentation.

� The external directory contains library files from other vendors that support 
Essbase Enterprise Services.

� The jre directory contains a copy of the Java Runtime Environment. This 
directory is present only if you chose to install Java during installation.

� The lib directory contains library files for Essbase Enterprise Services, 
including versions of the software that run as a Java servlet and an Enterprise 
Java Bean (EJB).

� The olap directory contains a runtime version of Essbase.

� The samples directory contains sample programs for use with Essbase 
Enterprise Services. For more information about the sample programs, see 
Chapter 5, “Setting up the Sample Programs.”

� The uninstallerdata directory contains information for uninstalling 
Essbase Enterprise Services.

Viewing Online Documentation on UNIX 
Systems

On UNIX systems, you must modify the startgui file in order to launch the 
online documentation properly from the Help menu of Essbase Enterprise Services 
Console.

Figure 11: Help Menu of Essbase Enterprise Services Console
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➤ To enable viewing of online documentation from the Help menu:

1. Edit startgui, located in the ESS_ES_HOME/bin directory, where 
ESS_ES_HOME is the directory where you installed Essbase Enterprise 
Services.

2. Add the following CODEBASE parameter to the java.com statement in 
startgui:

java.com.hyperion.essbase.beans.main.EssGuiConsole 
CODEBASE=ESS_ES_HOME username=guest password=password 
DOMAIN=essbase PREFSERVER=localhost ORBTYPE=tcpip PORTNO=
5001

where ESS_ES_HOME is the directory where you installed Essbase Enterprise 
Services.

3. Save the startgui file.

Selecting Help Topics or Product Documentation from the Help menu of Essbase 
Enterprise Services Console launches the documentation properly.

Installing Essbase Enterprise Services to Run as 
a Background Process

To Start the EES Server As Background Process on UNIX, you need to edit the 
Essbase.Properties file and make a change to the StartEES.sh command file.

In the Essbase.Properties file there is one line near the top that is used to turn the 
Console on.  That line is as follows:

# Embedded Command console.

system.cmdShell.start=true

Change the line to turn off the Console as follows:

system.cmdShell.start=false

In the Startees.sh file, edit the last line. Originally, the last line in the file is: 

java com.essbase.server.EssbaseEnterprise tcpip

Change that line as follows:

nohup java com.essbase.server.EssbaseEnterprise tcpip &

The change will take effect on the next restart of the machine.
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Chapter
4

Essbase Enterprise Ser
Configuring and Running 
Software Components
After installing Essbase Enterprise Services, you must configure it to work with 
your computer system and custom client programs. This chapter describes how to 
configure Essbase Enterprise Services servers, Essbase servers, Essbase server 
clusters, and connection pools, and explains how to start and stop Essbase 
Enterprise Services software components.

This chapter contains the following topics:

� “Configuring Essbase Enterprise Services Servers” on page 43

� “Configuring Essbase Servers” on page 57

� “Defining Clusters and Connection Pools” on page 59

� “Starting and Stopping Essbase Enterprise Services” on page 62

Configuring Essbase Enterprise Services 
Servers

Before you can run Essbase Enterprise Services servers, you must configure a 
database for storing domain information. You must also configure an Essbase 
Enterprise Services server to use TCP/IP, HTTP, EJB, or CORBA.

For information on configuring domain storage, see “Configuring Domain Storage 
for Essbase Enterprise Services” on page 44. For information on configuring 
Essbase Enterprise Services to use TCP/IP, HTTP, EJB, or CORBA, see 
“Configuring Servers to Use TCP/IP, HTTP, EJB, or CORBA” on page 46.
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Configuring Domain Storage for Essbase Enterprise 
Services

Essbase Enterprise Services requires a place to store information about domains, 
including domain names, servers, users, and groups. Two mechanisms are 
available for storing domain information:

� Java Database Connectivity (JDBC)-compliant Relational Database 
Management System (RDBMS)

� Flat file database, domain.db

Essbase Enterprise Services is configured to use the flat file database by default. 
This domain storage mechanism is suitable for development and testing purposes, 
but is not suited for production-level use. 

Note: Before putting Essbase Enterprise Services servers into production, you must 
configure them to use an RDBMS for domain information storage.

Configuring RDBMS Domain Storage
When you use Essbase Enterprise Services in a production environment, you must 
use an RDBMS for domain storage. You must have RDBMS software installed, 
such as IBM DB2, to create and use an RDBMS domain storage. RDBMS 
software is not included with Essbase Enterprise Services.

To configure Essbase Enterprise Services to use an RDBMS for domain storage, 
you must set up a database on the RDBMS server and edit the 
essbase.properties file.

➤ To configure an RDBMS database for domain storage:

1. Create a database called essbase in the RDBMS.

2. Add a user with full administrative rights to the database essbase; for 
example, db2admin with the password password.

Specific procedures for creating a new database varies with the RDBMS 
product you are using. For more information about creating a new database, 
see the documentation for the RDBMS product.

You do not need to create a database schema (tables and fields) in the new 
database. The database schema is created the first time Essbase Enterprise 
Services successfully connects to the RDBMS.
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➤ To configure domain storage to use an RDBMS database:

1. In the ESS_ES_HOME\bin directory, locate the essbase.properties file 
and open it in a text editor.

2. Set the domain.store.type variable to the value rdbms (all lower case); for 
example,

domain.store.type=rdbms 

3. Set the domain.store.rdbms variables to the appropriate values; for example,

domain.store.rdbms.product=DB2

domain.store.rdbms.jdbc.driver=
COM.ibm.db2.jdbc.net.DB2Driver

domain.store.rdbms.jdbc.url=jdbc:db2:localhost:essbase

domain.store.rdbms.user=db2admin

domain.store.rdbms.password=password

domain.store.rebms.connectionPool.capacity=2

Verify that the user and password you specify in these fields is the same as 
those created in the RDBMS in the previous procedure.

4. Save essbase.properties and close the file.

The essbase.properties file contains sample settings for DB2, Oracle, and 
SQL Server systems. Use the sample settings as a starting point for configuring the 
connection to your RDBMS database. For more information about configuring a 
JDBC connection to an RDBMS, refer to the documentation for the RDBMS 
product.

Configuring Flat File Domain Storage 
The installation program configures Essbase Enterprise Services to use the flat file 
database by default. To configure Essbase Enterprise Services to use a flat file for 
domain storage, you must edit the essbase.properties file.

➤ To configure domain storage to use a flat file:

1. In the ESS_ES_HOME\bin directory, locate the essbase.properties file 
and open it in a text editor.

2. Set the domain.store.type variable to the value file; for example,

domain.store.type=file
4
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3. Set the domain.store.file.name variable to the full path and file name of the 
domain storage file; for example,

domain.store.file.name=
c:/hyperion/essbase/essenterprise/data/domain.db

4. Save essbase.properties and close the file.

Configuring Servers to Use TCP/IP, HTTP, EJB, or CORBA
Essbase Enterprise Services servers can run using TCP/IP, HTTP, EJB, or 
CORBA configurations. Each of these types of implementations requires 
additional software components and configuration of these components. The type 
of server you set up depends on the type of client program technology you plan to 
use with Essbase Enterprise Services. If you simply want to start working with 
Essbase Enterprise Services, use the default TCP/IP configuration, which is 
created by the installation program.

For more information on the use of TCP/IP, HTTP, EJB, or CORBA technology 
with Essbase Enterprise Services, see “Understanding the Essbase Enterprise 
Services Development Platform” on page 17.

The following sections explain how to create Essbase Enterprise Services servers 
in these configurations:

� TCP/IP running Enterprise Services as a stand-alone program

� HTTP using WebLogic to run Enterprise Services as a servlet

� HTTP using Jigsaw to run Enterprise Services as a servlet

� EJB using WebLogic to run Enterprise Services as an EJB

� CORBA using VisiBroker as an ORB

The Jigsaw server is intended only for evaluation purposes and initial scalability 
testing. This server is not suitable for full production use with Essbase Enterprise 
Services.

For information on running the server configurations described here, see “Starting 
and Stopping Essbase Enterprise Services Servers” on page 62.
46 � Essbase Enterprise Services Installation Guide



Configuring and Running Software Components

4

4

4

4

4

4

4

4

4

ig_eds.book  Page 47  Thursday, June 20, 2002  8:20 PM
Configuring TCP/IP Servers
The installation program creates a TCP/IP implementation of Essbase Enterprise 
Services automatically. In this configuration, the Essbase Enterprise Services 
server runs as a stand-alone program and does not require any additional software.

Note: Essbase Enterprise Services client programs communicating with TCP/IP 
configurations of the server must use port 5001.

➤ To configure a TCP/IP server:

1. In the ESS_ES_HOME\bin directory, locate the essbase.properties file 
and open it in a text editor.

2. Set the system.dataDir variable to the Essbase Enterprise Services data 
directory; for example,

system.dataDir=../data

3. Verify that the domain storage is configured.

For more information about configuring domain storage, see “Configuring 
Domain Storage for Essbase Enterprise Services” on page 44.

4. Save essbase.properties and close the file.

5. In the ESS_ES_HOME\bin directory, locate the startees file (.cmd on 
Windows systems, .sh on UNIX systems) and open it in a text editor.

6. If you did not install the Java Runtime Environment with Essbase Enterprise 
Services, or if you want to use a different copy of Java, modify the 
JAVA_HOME variable.

In the startees file, find the line that starts with set JAVA_HOME= and 
modify this parameter to point to a copy of the Java Runtime Environment; for 
example,

set JAVA_HOME="C:\Program Files\JavaSoft\JRE\1.3\"

7. Save your changes and close the startees file.

For information on starting Essbase Enterprise Services TCP/IP servers, see 
“Starting and Stopping TCP/IP Servers” on page 63.
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Configuring HTTP/WebLogic Servers
An Essbase Enterprise Services server can run in a BEA WebLogic application 
server and use HTTP to communicate with client programs. This implementation 
of Essbase Enterprise Services requires that you have a copy of WebLogic Server 
installed on the computer running Essbase Enterprise Services. Once you have 
WebLogic Server installed, you can configure an Essbase Enterprise Services 
server that uses WebLogic and HTTP.

For information on starting a HTTP/WebLogic Essbase Enterprise Services server, 
see “Starting and Stopping HTTP/WebLogic Servers” on page 63.

➤ To configure a HTTP/WebLogic server:

1. In the ESS_ES_HOME\bin directory, locate the essbase.properties file.

2. Copy the essbase.properties file to the weblogic directory.

This version of the essbase.properties file will configure the settings for 
the Essbase Enterprise Services server running in the WebLogic server. 

Alternatively, you can create a file which points to a copy of the 
essbase.properties file in another directory. For more information, see 
“Creating Pointer Files to Essbase.properties” on page 87.

3. Using a text editor, open the copy of the essbase.properties file in the 
weblogic directory, which contains the weblogic.properties file.

4. Set the system.dataDir variable to the Essbase Enterprise Services data 
directory; for example,

system.dataDir=c:/hyperion/essbase/essenterprise/data

5. Verify that the domain storage is configured.

For more information about configuring domain storage, see “Configuring 
Domain Storage for Essbase Enterprise Services” on page 44.

6. Save essbase.properties and close the file.

7. In the weblogic directory, locate the weblogic.properties file and open 
the file in a text editor.

8. At the end of the weblogic.properties file, add the following line:

weblogic.httpd.register.EssbaseEnterprise=
com.essbase.server.plugins.http.EssbaseEnterprise

9. Save weblogic.properties and close the file.
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10. In the weblogic directory, locate the startWebLogic file (.cmd on 
Windows systems, .sh on UNIX systems) and open the file in a text editor.

11. At the beginning of the startWebLogic file, add the following lines:

set ESS_ES_HOME=c:\hyperion\essbase\essenterprise

set PATH=%ESS_ES_HOME%\bin;%PATH%;

set EES_CLASSPATH=
%ESS_ES_HOME%\lib\ess_japi.jar;%ESS_ES_HOME%\lib\ess_es_
server.jar;

set POST_CLASSPATH=%POST_CLASSPATH%;%EES_CLASSPATH%;

If you are using an RDBMS product for Enterprise Services domain storage, 
you must also add the .jar or .zip files containing the JDBC driver for that 
product to the POST_CLASSPATH; for example, if you are using DB2 for 
domain storage, you must add the db2java.zip file to the 
POST_CLASSPATH. For more information, see the documentation for the 
RDBMS product you are using for domain storage.

12. If necessary, change the value of the ESS_ES_HOME variable in the 
startWebLogic file to the installation directory for Essbase Enterprise 
Services.

13. Save startWebLogic and close the file.

Configuring HTTP/Jigsaw Servers
An Essbase Enterprise Services server can run in a Jigsaw Web server and use 
HTTP to communicate with client programs. This implementation of Essbase 
Enterprise Services requires that you have a copy of Jigsaw installed on your 
computer. Once you have Jigsaw installed, you can configure a Essbase Enterprise 
Services server that uses Jigsaw and HTTP.

The Jigsaw server is intended only for evaluation purposes and initial scalability 
testing. This server is not suitable for full production use with Essbase Enterprise 
Services.

For information on starting a HTTP/Jigsaw Essbase Enterprise Services server, see 
“Starting and Stopping HTTP/Jigsaw Servers” on page 64.

➤ To configure the Essbase Enterprise Services server and the Jigsaw script files:

1. In the ESS_ES_HOME\bin directory, locate the essbase.properties file.
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2. Copy the essbase.properties file to the jigsaw\scripts directory.

This version of the essbase.properties file configures the settings for the 
Essbase Enterprise Services server running in the Jigsaw server.

Alternatively, you can create a file which points to a copy of the 
essbase.properties file in another directory. For more information, see 
“Creating Pointer Files to Essbase.properties” on page 87.

3. In the jigsaw\scripts directory, open the copy of the 
essbase.properties file using a text editor.

4. Set the system.dataDir variable to point to the Essbase Enterprise Services 
data directory; for example,

system.dataDir=c:/hyperion/essbase/essenterprise/data

5. Verify that the domain storage is configured.

For more information about configuring domain storage, see “Configuring 
Domain Storage for Essbase Enterprise Services” on page 44.

6. Save essbase.properties and close the file.

7. In the jigsaw\scripts directory, locate the jigsaw.bat file and open the 
file in a text editor.

8. At the beginning of the jigsaw.bat file, add the following lines:

set ESS_ES_HOME=c:\hyperion\essbase\essenterprise

set JAVA_HOME=C:\progra~1\javasoft\jre\1.3

set PATH=%JAVA_HOME%\bin;%ESS_ES_HOME%\bin;%PATH%

Change the ESS_ES_HOME and the JAVA_HOME variables above to reflect 
the locations of Essbase Enterprise Services and the Java Runtime 
Environment on your computer.

9. After the line starting with set CLASSPATH, add the following line that 
contains an additional set CLASSPATH statement:

set CLASSPATH=
%CLASSPATH%;%ESS_ES_HOME%\lib\ess_japi.jar;%ESS_ES_HOME%
\lib\ess_es_server.jar;%ESS_ES_HOME%\thirdparty\db2_jdbc
\db2java.zip;

If you are using an RDBMS product for Enterprise Services domain storage, 
you must also add the .jar or .zip files containing the JDBC driver for that 
product to the CLASSPATH; for example, if you are using DB2 for domain 
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storage, you must add the db2java.zip file to the CLASSPATH. For more 
information, see the documentation for the RDBMS product you are using for 
domain storage.

10. Save jigsaw.bat and close the file.

11. In the jigsaw\scripts directory, locate the jigadmin.bat file and open 
the file in a text editor.

12. At the beginning of the jigadmin.bat file, add the following lines:

set JAVA_HOME=C:\progra~1\javasoft\jre\1.3

set PATH=%JAVA_HOME%\bin;%PATH%

Change the JAVA_HOME variable to reflect the location of the Java Runtime 
Environment on your computer.

13. Save jigadmin.bat and close the file.

14. In the jigsaw\scripts directory, locate the install.bat file and run it. 

➤ To configure the Jigsaw server to run the Essbase Enterprise Services servlet:

1. In the jigsaw\scripts directory, locate the jigsaw.bat file and run it.

2. In the jigsaw\scripts directory, locate the jigadmin.bat file and run it.

3. In the Authorization for JigAdmin dialog box, type a user name and 
password. The default administrative user name is admin and default 
password is admin.
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4. Click http-server.

Figure 12: Jigsaw http-server Administration Controls

5. In the Docs space tab, right-click the servlet folder and select Add resource 
to display the Add Resource dialog box.

6. In the Class name field, select org.w3c.jigsaw.servlet.ServletWrapper.

7. In the Identifier field, type EssbaseEnterprise and then click OK.

8. In the Docs space tab, open the servlet folder and right-click on 
EssbaseEnterprise, then select Edit resource to display the Edit Resource 
dialog box.

9. In the Servlet Class field, type the following class name: 
com.hyperion.essbase.server.plugins.http.EssbaseEnterprise

10. Click Commit and close the Edit Resource dialog box.

11. In the Docs space tab, right-click on the root folder and select Add resource 
to display the Add Resource dialog box.

12. In the Class name field, select org.w3c.jigsaw.servlet.ServletWrapper.

13. In the Identifier field, type EssbaseEnterprise and then click OK.

14. In the Docs space tab in the Root folder, right-click on the EssbaseEnterprise 
icon and select Edit resource to display the Edit Resource dialog box.
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15. In the Frames list, select the ServletWrapperFrame folder, then right-click it 
and select Delete frame.

16. In the Frames list, select the EssbaseEnterprise folder, then right-click it and 
select Add frame to display the Add Frame dialog box.

17. In the Class name field, select org.w3c.jigsaw.servlet.ServletMapperFrame 
and then click OK.

18. In the Frames list, select the ServletMapperFrame folder to display the 
Attributes list for this component in the Edit Resource dialog box.

19. In the servlet-url field, type /servlet/EssbaseEnterprise.

20. Click Commit and close the Edit Resource dialog box.

Figure 13: Jigsaw with Essbase Enterprise Services Servlet Added

21. Select the Properties tab and then click general.

22. In the Port field, type 7001.

23. Click Commit.

24. Exit the JigAdmin utility and restart the Jigsaw server.
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Configuring EJB/WebLogic Servers
An Essbase Enterprise Services server can run as an EJB in a WebLogic Java 
application server and use Remote Method Invocation (RMI) to communicate with 
other EJB client programs. This implementation of Essbase Enterprise Services 
requires that you have a copy of WebLogic Server installed on the computer 
running Essbase Enterprise Services. Once you have WebLogic Server installed, 
you can configure an Essbase Enterprise Services server that runs in WebLogic 
Server as an EJB program.

For information on starting an EJB/WebLogic Essbase Enterprise Services server, 
see “Starting and Stopping EJB/WebLogic Servers” on page 64.

➤ To configure an EJB/WebLogic server:

1. In the ESS_ES_HOME\lib directory, locate the ess_es_ejb.jar file.

2. Copy the ess_es_ejb.jar file to the weblogic\myserver directory.

3. In the ESS_ES_HOME\bin directory, locate the essbase.properties file.

4. Copy the essbase.properties file to the weblogic directory.

This version of the essbase.properties file configures the settings for the 
Essbase Enterprise Services server running in the WebLogic server.

Alternatively, you can create a file which points to a copy of the 
essbase.properties file in another directory. For more information, see 
“Creating Pointer Files to Essbase.properties” on page 87.

5. Using a text editor, open the copy of the essbase.properties file in the 
weblogic directory, which contains the weblogic.properties file.

6. Set the system.dataDir variable to point to the Essbase Enterprise Services 
data directory; for example,

system.dataDir=c:/hyperion/essbase/essenterprise/data

7. Verify that the domain storage is configured.

For more information about configuring domain storage, see “Configuring 
Domain Storage for Essbase Enterprise Services” on page 44.

8. Save essbase.properties and close the file.

9. In the weblogic directory, locate the weblogic.properties file and open 
the file in a text editor.
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10. In the EJB section of the weblogic.properties file, before the 
WEBLOGIC EJB DEMO PROPERTIES title, add the following line:

weblogic.ejb.deploy=C:/weblogic/myserver/ess_es_ejb.jar

If necessary, change directory path shown in the preceding example to the 
location where you copied the ees_es_ejb.jar file.

11. Save weblogic.properties and close the file.

12. In the weblogic directory, locate the startWebLogic file (.cmd on 
Windows systems, .sh on UNIX systems), and open the file in a text editor.

13. At the beginning of the startWebLogic file, add the following lines:

set ESS_ES_HOME=c:\hyperion\essbase\essenterprise

set PATH=%ESS_ES_HOME%\bin;%PATH%;

set EES_CLASSPATH=%ESS_ES_HOME%\lib\ess_japi.jar; 
%ESS_ES_HOME%\lib\ess_es_server.jar;%ESS_ES_HOME%\thirdp
arty\db2_jdbc\db2java.zip;

set POST_CLASSPATH=%POST_CLASSPATH%;%EES_CLASSPATH%;

If you are using an RDBMS product for Enterprise Services domain storage, 
you must also add the .jar or .zip files containing the JDBC driver for that 
product to the POST_CLASSPATH; for example, if you are using DB2 for 
domain storage, you must add the db2java.zip file to the 
POST_CLASSPATH. For more information, see the documentation for the 
RDBMS product you are using for domain storage.

14. If necessary, change the value of the ESS_ES_HOME variable in the 
startWebLogic file to the installation directory for Essbase Enterprise 
Services.

15. Save startWebLogic and close the file.

Configuring CORBA/VisiBroker Servers
An Essbase Enterprise Services server can use CORBA/VisiBroker software to 
communicate with client programs. This implementation of Essbase Enterprise 
Services requires that you have a copy of VisiBroker installed on the computer 
running Essbase Enterprise Services and on the computer running the Essbase 
Enterprise Services client program. Once you have VisiBroker installed, you can 
configure a Essbase Enterprise Services server that runs with VisiBroker as an 
stand-alone Java program.
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After installing VisiBroker, add the vbjorb.jar file to the classpath and run the 
osagent.exe file before starting the Essbase Enterprise Services server. See the 
ESS_ES_HOME\bin\startees.cmd file for an example of how to automate 
these steps in a script file.

➤ To configure a CORBA/VisiBroker server:

1. In the ESS_ES_HOME\bin directory, locate the essbase.properties file 
and open it in a text editor.

2. Set the system.dataDir variable to the Essbase Enterprise Services data 
directory; for example,

system.dataDir=../data

3. Verify that the domain storage is configured.

For more information about configuring domain storage, see “Configuring 
Domain Storage for Essbase Enterprise Services” on page 44.

4. Save essbase.properties and close the file.

5. In the ESS_ES_HOME\bin directory, locate the startees file (.cmd on 
Windows systems, .sh on UNIX systems) and open it in a text editor.

6. If you did not install the Java Runtime Environment with Essbase Enterprise 
Services, or if you want to use a different copy of Java, modify the 
JAVA_HOME variable.

In the startees file, find the line that starts with set JAVA_HOME= and 
modify this parameter to point to a copy of the Java Runtime Environment; for 
example,

set JAVA_HOME="C:\Program Files\JavaSoft\JRE\1.3\"

7. Save your changes and close the startees file.

For information on starting Essbase Enterprise Services CORBA/VisiBroker 
Server, see “Starting and Stopping CORBA/VisiBroker Servers” on page 64.
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Configuring Essbase Servers
Before using Essbase servers with Essbase Enterprise Services, you must 
configure the Essbase servers to better support concurrent usage, create replicas of 
your application, and create users for Essbase Enterprise Services. In addition, for 
Essbase servers running on Windows systems, you should configure them for 
remote activation.

➤ To configure Essbase servers for use with Essbase Enterprise Services:

1. On the computer running Essbase server, in the ARBORPATH\bin directory, 
locate the essbase.cfg file. If the essbase.cfg file does not exist, create 
one using a text editor.

2. For Essbase servers used in a production system with Essbase Enterprise 
Services, consider adding the following lines to the essbase.cfg file:

AGENTLOGMESSAGELEVEL ERROR
LOGMESSAGELEVEL      ERROR

These settings reduce the amount of messages that are logged by the Essbase 
server. Under heavy use, Essbase logs can become very large and unusable by 
the server, requiring that you delete the log or reduce its size. Adding these 
settings will reduce the amount of information recorded in the logs and, 
consequently, reduce the need to manage the logs. To permanently solve 
problems with overlarge log files, consider adding the following line to the 
essbase.cfg file:

CLEARLOGFILE TRUE

The CLEARLOGFILE setting causes Essbase to clear the log file before 
recording any new message, so that only the last message is available in the 
log file. For more information about these essbase.cfg file settings, see the 
Hyperion Essbase Technical Reference in the docs directory. 

3. If you plan to use Essbase servers in a cluster configuration with Essbase 
Enterprise Services, you must make copies of the Essbase application that the 
cluster will serve on each of the Essbase servers in the cluster.

To gain a minimal benefit of load balancing and failover from Essbase 
Enterprise Services, you must set up at least a main application with a database 
and one replica application with an identical database. For more information 
about setting up clusters, see “Defining Clusters and Connection Pools” on 
page 59.
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For more information about copying Essbase applications, see the Hyperion 
Essbase Database Administrator’s Guide.

4. Create users and their access permissions on each of the Essbase servers to use 
with Essbase Enterprise Services.

For more information about creating users in Essbase, see the Hyperion 
Essbase Database Administrator’s Guide.

For more information about creating users across a cluster of Essbase servers, 
see “Synchronizing Users and Security Across a Cluster” on page 77.

Configuring Essbase Servers for Remote Activation
You can enable Essbase Enterprise Services to start an Essbase server on a remote 
Windows NT system. You need to have the appropriate privileges and you must 
specify the exact path of the Essbase server on the remote machine. This feature 
uses DCOM activation on both machines. 

➤ To configure remote activation of Essbase servers on Windows systems:

1. Run the batch file regact.cmd in the ESS_ES_HOME\bin directory. This 
updates the registry to enable DCOM activation.

2. Copy regact.cmd and eds_rexec.exe to the /bin directory of the remote 
Essbase server.  Run regact.cmd (it calls eds_rexec.exe). 

3. Edit the file startolap.cmd in the ESS_ES_HOME\bin. The ARBORPATH 
entry must specify the path of the Essbase home directory on the remote 
machine. The entries in the startolap.cmd file should appear as follows:

@echo off

REM This command file is used to start the Essbase OLAP server.

REM Make sure to change the ARBORPATH to suit your setup.

REM For remote activation set ARBORPATH to point to the remote machine.

set ARBORPATH=C:\hyperion\essbase

set PASSWORD=%1

set PATH=%ARBORPATH%\bin;%PATH%;

essbase %PASSWORD%

4. Copy startolap.cmd to the /bin directory of the remote Essbase server.
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5. Using the Enterprise Services Console, add the remote Essbase server to the 
Enterprise Services domain. Set the server property named Remote start 
command to ESS_ES_HOME\bin\startolap.cmd <password> (for 
example, c:\essbase\ees\bin\startolap.cmd password. Save the 
server properties. 

6. Edit startees.cmd and make sure all directories are specified as absolute 
paths.  

7. Edit the essbase.properties file to replace system.dataDir=..\data 
with the absolute path. For example, c:\essbase\ees\data. 

8. In the EES Console, add the Enterprise server to the Essbase Enterprise 
domain, and set the Remote start command property to the absolute pathe of 
the startees.cmd file. 

9. Remote activation is now enabled. From the EES Console, select olap or 
enterprise server, and select Control>Start. 

Defining Clusters and Connection Pools
Essbase server clusters and connection pools enable Essbase Enterprise Services 
to provide features of load balancing, failover, and handling of large concurrent 
loads. If you do not use clusters and connection pools in your client programs, you 
are not taking advantage of the primary benefits of using Essbase Enterprise 
Services.

A cluster of Essbase servers is a set of servers running on different computers (or 
different CPUs, on multi-processor systems) that run copies, or replicas, of the 
same Essbase application, a single Essbase server that runs replicas of the same 
application, or a combination of both.

A connection pool is set of login sessions from Essbase Enterprise Services to a 
Essbase server. Enterprise Services uses a connection pool to process requests for 
Essbase services.

Clusters and connection pools are defined in the essbase.properties file and 
can be used only through client programs. These features are not configurable 
through the Console or the Command Shell. In general, client programs should 
take advantage of clusters and connection pools by using connection pools that 
include clusters. Thus, in general, you should include a cluster in your connection 
pool to take full advantage of the features of Essbase Enterprise Services.
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For an example of a client program that uses connection pools and clusters, refer 
to the DataQuery sample program in the ESS_ES_HOME\samples directory. For 
more information about the sample programs, see Chapter 5, “Setting up the 
Sample Programs.” For more information about using clusters and connection 
pools in client programs, see the IEssCube.openCubeView method and related 
methods in the online Hyperion Essbase JAPI Reference in the Essbase Enterprise 
Services DOCS directory. 

Defining Essbase Server Clusters
Essbase servers must be configured to be used effectively with Essbase Enterprise 
Services. For more information about configuring Essbase servers for use in a 
cluster, see “Configuring Essbase Servers” on page 57.

Essbase Enterprise Services enables you to group sets of Essbase servers running 
applications with identical databases and use them as a single resource in your 
client programs. Clustering of servers enables features such as load balancing and 
failover support. Load balancing enables requests to Essbase servers to be 
distributed across a cluster of Essbase servers running identical databases. Failover 
support detects service interruptions in a cluster, and reroutes requests to other 
available Essbase servers in a cluster. You must restart the server to reflect changes 
to the cluster.

To define a cluster:

1. In the navigation panel, select a domain under Domains or select Clusters if 
clusters have already been created.

2. Right-click, then select Create > Cluster.

3. In the dialog that is displayed, type the name for your cluster; for example, 
mycluster.

4. Click OK. 

5. In the navigation panel, select the cluster that you have just created.

6. In the cluster's properties panel, set the service component name; for example,
     localhost/Demo/Basic;localhost/Demo2/Basic.

7. Click Save.

8. Specify the cluster name in the properties panel of the Enterprise Services 
server for which you want to associate the cluster.
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After configuring a set of Essbase servers for use in a cluster, you must define and 
enable the cluster in the Enterprise Services Console.  For complete instructions on 
configuring clusters refer to the online Essbase Enterprise Services Console Help 
in the Essbase Enterprise Services DOCS directory.

Defining Connection Pools
Connection pools are defined in the Enterprise Services Console. For complete 
information on configuring connection pools refer to the online Essbase 
Enterprise Services Console Help in the Essbase Enterprise Services DOCS 
directory.

Essbase Enterprise Services enables client requests to share connections, which 
conserves software and network resources, and improves performance. You must 
restart the Enterprise Services server to reflect changes to the connection pool.

To define a connection pool:

1. In the navigation panel, select a domain under Domains or select Connection 
Pools if connection pools have already been created.

2. Right-click, then select Create > Connection Pool.

3. In the dialog that is displayed, type the name for your connection pool; for 
example, mypool.

4. Click OK. 

5. In the navigation panel, select the connection pool that you have just created.

6. In the connection pool’s properties panel, set the service component name for 
the cluster associated with the connection pool; for example, mycluster.

7. Enable the check box for the service component.

8. Enter the username and password.

9. Set the initital capacity, maximum capacity, capacity increment.

10. Specify whether to enable access for everyone.

11. Click Save.

12. Specify the connection pool name in the properties panel of the Enterprise 
Services server you want to associate with the connection pool.
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Starting and Stopping Essbase Enterprise 
Services 

Essbase Enterprise Services contains several software components in that you 
must start and stop separately. Depending on the configuration of the Essbase 
Enterprise Services server, there are different procedures for starting and stopping 
it. For more information about starting Essbase Enterprise Services server, see 
“Starting and Stopping Essbase Enterprise Services Servers” on page 62.

You must start the server components of Essbase Enterprise Services, shown in the 
following list, before starting the other components of Essbase Enterprise 
Services:

� Essbase servers

� Essbase Enterprise Services servers

For information about starting Essbase servers, see the Hyperion Essbase 
Installation Guide.

After the preceding software components have been started, you can start the 
following components in any order:

� Essbase Enterprise Services Console

� Essbase Enterprise Services Command Shell

� Essbase Enterprise Services client programs

Starting and Stopping Essbase Enterprise Services 
Servers

Essbase Enterprise Services servers can be configured in multiple ways. Each 
configuration uses different technology and supporting software. This section 
describes how to start and stop the following Essbase Enterprise Services server 
configurations:

� TCP/IP servers

� HTTP/WebLogic servers

� HTTP/Jigsaw servers

� EJB/WebLogic servers

� CORBA/VisiBroker servers
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For more information about configuring the different types of Essbase Enterprise 
Services servers, see “Configuring Servers to Use TCP/IP, HTTP, EJB, or 
CORBA” on page 46.

Starting and Stopping TCP/IP Servers
Starting the Essbase Enterprise Services TCP/IP server requires that you run a 
command script. For information about configuring the command script, see 
“Configuring TCP/IP Servers” on page 47.

➤ To start a TCP/IP server:

1. At a command prompt, change to the ESS_ES_HOME\bin directory, locate the 
startees file (.cmd on Windows systems, .sh on UNIX systems).

2. Run the startees file with the input parameter TCPIP; for example:

>startees tcpip

➤ To stop a TCP/IP server:

1. Click the window for the TCP/IP server and press Enter.

2. At the prompt, type exit and press Enter.

Starting and Stopping HTTP/WebLogic Servers
Starting the Essbase Enterprise Services server requires that you run a WebLogic 
command script. For information about configuring Essbase Enterprise Services 
and WebLogic to run a HTTP implementation of the Essbase Enterprise Services 
server, see “Configuring HTTP/WebLogic Servers” on page 48.

➤ To start a HTTP/WebLogic server:

1. In the weblogic directory, locate the startWebLogic file (.cmd on 
Windows systems, .sh on UNIX systems).

2. Run the startWebLogic file.
4
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➤ To stop a HTTP/WebLogic server, close the WebLogic server window.

Starting and Stopping HTTP/Jigsaw Servers
Starting the Essbase Enterprise Services server requires that you run a Jigsaw 
command script. For information about configuring Essbase Enterprise Services 
and Jigsaw to run a HTTP implementation of the Essbase Enterprise Services 
server, see “Configuring HTTP/Jigsaw Servers” on page 49.

➤ To start a HTTP/Jigsaw server:

1. In the jigsaw\scripts directory, locate the jigsaw.bat file.

2. Run the jigsaw.bat file.

➤ To stop a HTTP/Jigsaw server:

1. Select the Jigsaw server window.

2. Press Ctrl + c and type y to exit the server.

Starting and Stopping EJB/WebLogic Servers
Starting the Essbase Enterprise Services server requires that you run a WebLogic 
command script. For information about configuring Essbase Enterprise Services 
and WebLogic to run an EJB implementation of the Essbase Enterprise Services 
server, see “Configuring EJB/WebLogic Servers” on page 54.

➤ To start an EJB/WebLogic server:

1. In the weblogic directory, locate the startWebLogic file (.cmd on 
Windows systems, .sh on UNIX systems).

2. Run the startWebLogic file.

➤ To stop an EJB/WebLogic server, close the WebLogic server window.

Starting and Stopping CORBA/VisiBroker Servers
Starting the Essbase Enterprise Services server requires that you run a command 
script. For information about configuring the command script, see “Configuring 
CORBA/VisiBroker Servers” on page 55.
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➤ To start a CORBA/VisiBroker server:

1. At a command prompt, change to the ESS_ES_HOME\bin directory, locate the 
startees file (.cmd on Windows systems, .sh on UNIX systems).

2. Run the startees file with the input parameter CORBA; for example:

>startees corba

➤ To stop a CORBA/VisiBroker server:

1. Click the window for the CORBA/VisiBroker server and press Enter.

2. At the prompt, type exit and press Enter.

Starting and Stopping the Enterprise Services Console
The Essbase Enterprise Services Console is a graphical interface that enables you 
to manage Essbase Enterprise Services domains, servers, users, and groups. You 
must have a Essbase Enterprise Services server running to start the Console.

For more information about using the Console, see the online Essbase Enterprise 
Services Console Help in the Essbase Enterprise Services DOCS directory.

➤ To start the Console:

1. Verify that the Essbase Enterprise Services server is running.

2. In the ESS_ES_HOME\bin directory, locate the startgui file (.cmd on 
Windows systems, .sh on UNIX systems).

3. Run the startgui file.

4. In the User Name field, type a user name; for example, admin.

5. In the Password field, type a password; for example, password.

6. In the Domain field, type the name of a Essbase Enterprise Services domain; 
for example, essbase.

The default domain for Essbase Enterprise Services is essbase.

7. In the Preferred Server field, type the host name or numeric IP address of the 
computer running Essbase Enterprise Services; for example, sequoia2 or 
254.0.0.26.

You can find a running Essbase Enterprise Services server on the local 
network by clicking Locate.
4
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8. In the ORB field, select the type of Essbase Enterprise Services server you are 
logging on to; for example, HTTP.

If you specify an option other than CORBA, you must also specify the port 
number of the Java application server or Web server in the Port No field.

9. Click Sign On to log on to the Essbase Enterprise Services server and start the 
Console.

➤ To stop the Console, in the Console window, select File > Exit.

Starting and Stopping the Enterprise Services Command 
Shell

The Essbase Enterprise Services Command Shell is a command-line interface that 
provides basic tools to manage Essbase Enterprise Services servers and users. You 
must have an Essbase Enterprise Services server running to start the Command 
Shell.

For more information about using the Command Shell commands, see “Command 
Shell Commands” on page 89.

➤ To start the Command Shell:

1. Verify that the Essbase Enterprise Services server is running.

2. In the ESS_ES_HOME\bin directory, locate the startcmd file (.cmd on 
Windows systems, .sh on UNIX systems).

3. Run the startcmd file.

4. At the prompt, use the signon command to log on to the Essbase Enterprise 
Services server; for example, type:

ESS>signon

5. At the next prompt, type a Essbase Enterprise Services user name, password, 
domain name, server name, and server type, separated by commas; for 
example,

admin,password,essbase,sequoia2,corba, port#

6. Press Enter to log on to the Essbase Enterprise Services server.

➤ To stop the Command Shell, in the Command Shell window at the prompt, type 
Exit.
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Chapter
5

Essbase Enterprise Ser
Setting up the Sample 
Programs
Essbase Enterprise Services includes a set of sample Java programs for testing the 
product and to use as a reference when developing custom client programs. This 
chapter discusses the sample programs, how to set up your computer environment 
to work with them, and how to compile and run them.

This chapter contains the following topics:

� “Understanding the Sample Programs” on page 67

� “Configuring Essbase Servers” on page 69

� “Configuring Essbase Enterprise Services Servers” on page 70

� “Compiling and Running the Sample Programs” on page 70

� “Next Steps” on page 73

Understanding the Sample Programs
The sample programs provided with Essbase Enterprise Services help you test the 
software and get you started on developing client programs for Essbase Enterprise 
Services. In order to run the sample programs, you must configure your 
environment with the following components:

� An Essbase Enterprise Services server

� A supported Essbase server with users and sample applications

For information about setting up Essbase Enterprise Services for the sample 
programs, see “Configuring Essbase Enterprise Services Servers” on page 70. For 
information about setting up Essbase for the sample programs, see “Configuring 
Essbase Servers” on page 69.
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Unless otherwise noted in this document, the sample programs assume that all 
necessary software components (Essbase Enterprise Services, Essbase, and the 
sample programs themselves) are running on the same computer.

The sample programs demonstrate areas of functionality provided through the 
Essbase JAPI. The sample programs are located in the ESS_ES_HOME\samples 
directory. The areas covered by each sample program are summarized in the 
following list:

� Connect.java, demonstrates a simple connection and disconnection from a 
Essbase Enterprise Services server

� DataQuery.java, demonstrates basic retrieval of data from a Essbase 
database

� DataSource.java, demonstrates the retrieval of Essbase server information 
and execution of reports

� Domain.java, demonstrates management of Essbase Enterprise Services 
domains, including adding and removing of users, groups, domains, Essbase 
servers, and Essbase Enterprise Services servers

� MetaData.java, demonstrates retrieval of metadata information from a 
Essbase database, including member selection

� GridDataUpdate.java, demonstrates the retrieving and updating of data in 
a grid format

� RunReport.java, demonstrates the running of a report from a Essbase 
database

� ViewOutlineTree.java, demonstrates the listing of all outline members 
from Essbase database outline

� SyncCubeReplicas.java, demonstrates the replication of data between 
two Essbase databases

� UserCustomPreference.java, demonstrates the setting of a custom 
preference for a user on a Essbase Enterprise Services server

� ClientCache.java, demonstrates the setting and use of client-side cach-ing 
with the Essbase JAPI
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The sample programs can use an Essbase Enterprise Services server that uses a 
supported configuration; for example, CORBA/VisiBroker. For more information 
about creating client programs that work with Essbase Enterprise Services servers, 
see the online Hyperion Essbase JAPI Reference in the Essbase Enterprise 
Services DOCS directory.

Configuring Essbase Servers
The sample programs require a Essbase Release 6.1 patch 3 or later server with the 
Demo Basic sample application loaded. You must also create the users admin and 
guest on the Essbase server.

If you plan to use several Essbase servers in a cluster with the sample programs, 
you must perform the following procedure for all Essbase servers in the cluster.

➤ To configure Essbase servers for use with the sample programs:

1. On the Essbase server, verify that the sample applications Demo Basic and 
Sample Basic are installed and that the databases have been loaded with data. 
For information about installing the sample applications in Essbase, see the 
Hyperion Essbase Installation Guide.

2. If you are going to use the SyncCubeReplicas sample program, make a copy 
of the Demo application and name it Demo2. For information about copying 
Essbase applications, see the Hyperion Essbase Database Administrator’s 
Guide.

3. On the Essbase server, create the following users: 

� system, a user with supervisor rights and a password of password

� guest, a normal user with read access to the Demo application (and the 
Demo2 application, if created) and a password of password

For information on creating users in Essbase, see the Hyperion Essbase 
Database Administrator’s Guide.

4. After completing these steps, keep the Essbase server running. 

You do not have to keep the Essbase Demo and Demo2 applications running. 
Essbase Enterprise Services starts these applications automatically when they 
are required.
5
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Configuring Essbase Enterprise Services 
Servers

In order to use the sample programs, you must configure and run an instance of the 
Essbase Enterprise Services server that uses one of the supported configurations; 
for example, CORBA/VisiBroker. For information on configuring an instance of 
the server, see “Configuring Servers to Use TCP/IP, HTTP, EJB, or CORBA” on 
page 46.

Once you have configured an instance of the server, you must perform additional 
configuration so you can use it with the sample programs.

➤ To configure a Essbase Enterprise Services server for use with the sample 
programs:

1. In the ESS_ES_HOME\bin directory, locate the essbase.properties file 
and open it in a text editor.

The essbase.properties file may be located in a different directory, 
depending on the type of server you are using. For more information, see 
“Essbase Enterprise Services File Locations” on page 88.

2. In the essbase.properties file, find the line that starts with 
olap.server.autoStart= and set this parameter to true; for example,

olap.server.autoStart=true

This setting enables the Essbase Enterprise Services server to start 
applications automatically on connected Essbase servers.

3. Save your changes and close the essbase.properties file.

After you have set this parameter, you must stop and restart the Essbase Enterprise 
Services server. For information on starting servers see, “Starting and Stopping 
Essbase Enterprise Services Servers” on page 62.

Compiling and Running the Sample Programs
After you have configured the required servers, you can then compile and run the 
sample programs.
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The script file runsamples is provided for compiling the sample programs. This 
script must be configured to work with your computer environment. Once you 
have this script working in your environment, you can use it as a template for 
creating compile and run scripts for the other sample programs. 

Configuring the runsamples Script File
To configure the runsamples script file to work in your computer environment, you 
must verify that the path and other environment variables in the script are set 
correctly.

➤ To configure the runsamples file to work with your computer environment:

1. In the ESS_ES_HOME\samples directory, locate the runsamples script 
(.cmd on Windows systems, .sh on UNIX systems).

2. Open the runsamples script in a text editor.

3. Verify that the ESS_ES_HOME variable is set to the location of your Essbase 
Enterprise Services installation; for example,

set ESS_ES_HOME=C:\hyperion\essbase\essenterprise\

4. Verify that the JAVA_HOME variable points to a supported version of the Java 
Runtime Environment. If you did not install the Java Runtime Environment 
with Essbase Enterprise Services, you must update this variable with a full 
path to the Java installation; for example,

set JAVA_HOME="C:\Program Files\JavaSoft\JRE\1.3\"

5. Replace the variable values for USER, PASSWORD, DOMAIN, 
EES_SERVER, and OLAP_SERVER, as necessary. These variables are set at 
the beginning of the runsamples file.

Tip: To make running the example programs easier, set up Essbase Enterprise 
Services and Essbase on your local computer. Then, in Essbase, create a user 
system with a password of password and full access to the Sample Basic, Demo 
Basic, and Demo2 Basic databases. If you set up your computer system in this 
configuration, you do not need to modify the default settings for the sample client 
programs.

6. Save the runsamples script file.
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Running the runsamples Script
After you have configured the runsamples script to work with your environment, 
you are ready to run the script, which compiles the sample programs and runs one 
of them.

➤ To run the runsamples script:

1. Verify that the Essbase Enterprise Services server and Essbase server are 
running.

2. In the ESS_ES_HOME\samples directory, locate the runsamples script 
(.cmd on Windows systems, .sh on UNIX systems).

3. Run the script by typing the following command at the command prompt:

>runsamples corba

This example runs the sample program for a Essbase Enterprise Services 
server that uses CORBA. For other server types, replace CORBA with the 
server type you are using.

4. Follow the on-screen prompts to compile and run the sample programs.

Creating Compile and Run Scripts
The runsamples script compiles all the sample programs but runs only one of them. 
To run the other sample programs, you must create your own scripts or modify the 
runsamples script.

You can use the runsamples script as a template for new scripts. The following 
procedure shows you how to create a version of the runsamples script to run a 
different sample program.

➤ To create a version of the runsamples script to run another sample program:

1. In the ESS_ES_HOME\samples directory, locate the runsamples script 
(.cmd on Windows systems, .sh on UNIX systems).

2. Open the runsamples script in a text editor.

3. In the script file, find the line that begins with echo Step-2 and modify the 
two lines as shown below:

echo Step-2: Ready to run MetaData example ...

pause
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%JAVA_HOME%\bin\java %VBROKER_PROPS% 
com.hyperion.essbase.samples.MetaData %USER% %PASSWORD% 
%DOMAIN% %EES_SERVER% %ORB% %PORT% %OLAP_SERVER%

To use the script to run another sample program, substitute the name of the 
sample program class for MetaData, as shown in the preceding sample.

4. Configure this script to work in your computer environment by performing the 
procedure described in “Configuring the runsamples Script File” on page 71.

5. Save the script file in the ESS_ES_HOME\samples directory. Save the file 
with an extension .cmd on Windows systems or a.sh extension on UNIX 
systems.

Running Compile and Run Scripts
After you have created compile and run scripts for the other sample programs and 
configured them to work with your computer environment, you are ready to run 
these scripts.

➤ To run the compile and run scripts:

1. Verify that the Essbase Enterprise Services server and Essbase server are 
running.

2. In the ESS_ES_HOME\samples directory, locate the script file (.cmd on 
Windows systems, .sh on UNIX systems).

3. Run the script by double-clicking the file or by typing the name of the script 
command at the command prompt.

4. Follow the on-screen prompts to compile the sample program and run it.

Next Steps
After you have successfully compiled and run the sample programs, you are ready 
to create your own client programs for Essbase Enterprise Services. 

For more information about the available classes and methods in the Essbase JAPI, 
see the online Hyperion Essbase JAPI Reference in the Essbase Enterprise 
Services DOCS directory.
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Chapter
6

Essbase Enterprise Ser
System Administration
This chapter discusses administration tasks for system administrators of Essbase 
Enterprise Services, including managing data and security information in a 
Essbase server cluster.

Managing Essbase Server Clusters
Using Essbase Enterprise Services with clusters of Essbase servers creates a new 
set of tasks for Essbase system administrators. In particular, administrators must 
develop strategies for synchronizing data and security information across multiple 
Essbase servers.

The Essbase Enterprise Services and Essbase teams are working toward solutions 
to these server management challenges. In the meantime, the following sections 
provide strategies for managing data and security synchronization.

Outline Caching
Essbase Enterprise Services has the option of storing outline information along 
with other services information. This option makes it possible to keep the outline 
of a specific Essbase database locally on the Enterprise Services server eliminating 
unnecessary queries of the database itself.  This option is enabled through the 
Essbase Enterprise Services console and can be set and reset as required. Outline 
Caching is set by specifying the absolute path to the For more information refer to 
the Essbase Enterprise Services Console Help.

External Authentication
Essbase Enterprise Services allows the authentication of users external to the 
security measures present in the Essbase database itself. Security authentication of 
users can be done through four different schemes: 
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� Enterprise server - Essbase Enterprise server authentication (default). 

� LDAP - LDAP authentication. 

� Windows NT - Windows NT authentication. 

� Custom - virtually any external authentication scheme can be used, provided 
it is set up correctly. 

The internal authentication by Essbase Enterprise Services is the default scheme. 
The external authentication schemes (LDAP, Windows NT, and Custom) are set 
up by editing the Essbase Properties file (essbase.properties is in 
ESS_HOME\bin).  Refer to the online Essbase.properties Reference in the 
Essbase Enterprise Services DOCS directory. 

Synchronizing Data Across a Cluster
There are three general strategies for replicating data across a cluster:

� Using the features of Essbase Partitioning to create replicated partitions of the 
served application on each Essbase server

� Using Essbase Integration Server to load data onto each server in the cluster

� Exporting data from the master server and loading it into each Essbase server

Synchronizing Data Using Partitioning
The Essbase Partitioning module enables you to create replicated partitions of a 
database over multiple Essbase servers. By creating replicated database partitions 
which mirror each other on each of the servers in a Essbase server cluster, you can 
effectively synchronize data across multiple Essbase servers.

For more information about using Partitioning, see the Hyperion Essbase 
Database Administrator’s Guide.

Synchronizing Data Using Essbase Integration Server
Essbase Integration Server enables you to load data into Essbase databases quickly 
and easily. If you use Essbase Integration Server to load and update your master 
Essbase application for a cluster, you can also use it to load and update the other 
mirror application on the other Essbase servers in a cluster.

For more information about using Essbase Integration Server, see the Hyperion 
Essbase Integration Services System Administrator’s Guide.
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Synchronizing Data Using Export and Load Functions
Essbase provides a basic solution to synchronizing data between servers in the data 
export and import features. Using this methodology you export the data from the 
master Essbase database and import it into the other servers in the cluster.

Essbase Enterprise Services provides a command to perform this type of 
synchronization in the Command Shell. This command uses the Essbase JAPI 
method IEssDomain.syncCubeReplicas(). A sample client program demonstrating 
this method is provided in the ESS_ES_HOME\samples directory. The sample 
program file is named SyncCubeReplicas.java.

For more information about the Command Shell, see “Command Shell 
Commands” on page 89. For more information about the sample programs, see 
Chapter 5, “Setting up the Sample Programs.” For more information about using 
exporting and loading data, see the Hyperion Essbase Database Administrator’s 
Guide.

Synchronizing Users and Security Across a Cluster
When you create a cluster of Essbase servers with Essbase Enterprise Services, 
you must add users and their relevant access permissions to all Essbase servers in 
the cluster. If you have large numbers of users, this can be time consuming.

Essbase Enterprise Services provides a command for loading Essbase users into its 
domain storage and settings for pushing those users to other Essbase servers in a 
cluster, but the information is incomplete. For more information see, “Loading 
Essbase Users into Essbase Enterprise Services” on page 77.

Beyond the procedure mentioned above, consider creating users and access 
information on the master Essbase server using a MaxL or ESSCMD script and 
reuse this script on the other servers in the cluster. Finally, you may have to 
manually replicate some user and access information across the servers of your 
cluster. For more information about using MaxL and ESSCMD, see Hyperion 
Essbase Technical Reference in the docs directory.

Loading Essbase Users into Essbase Enterprise Services
Essbase Enterprise Services provides a way to load users from a Essbase server 
and then push those user names and passwords onto other Essbase servers. The 
process requires that the Enterprise Services server reset all the passwords on the 
Essbase server and the push process creates the users but does not replicate their 
privileges on the other Essbase servers.
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➤ To load users into Essbase Enterprise Services from a Essbase server:

1. Verify that the Essbase Enterprise Services server and the Essbase server 
containing the users you want to load are running.

2. In the ESS_ES_HOME\bin directory, locate the startCmdShell file (.cmd 
on Windows systems, .sh on UNIX systems).

3. Run the startCmdShell file.

4. Log on to the Essbase Enterprise Services server using the signon command; 
for example,

EES>signon
Enter input as user,passwd,domain,prefServer,plugin:
system,password,essbase,localhost,corba

5. Use the syncsectoees command to load the user name information into the 
Essbase Enterprise Services server and reset the password to a default value 
on both servers; for example,

EES>syncsectoees
Enter input as olapSvrName,domName,defPwd,syncPwd:
localhost,essbase,password,true

CAUTION: Performing this operation resets the passwords for all users on 
the Essbase server.

User names and passwords are now the same on the Essbase Enterprise 
Services server and Essbase server with which you connected.

After loading the user names, you can configure the Essbase Enterprise Services 
server to create user names on Essbase servers as it connects to them. The settings 
for this configuration are set in the essbase.properties file.

Essbase Enterprise Services can not create users and passwords automatically on 
the Essbase servers with which it connects. Create all needed user accounts 
directly on the Essbase servers. If necessary you can replicate the user list on 
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additional Essbase servers. If a user changes a password through an Essbase 
Enterprise Services client program, that password is loaded on to the Essbase 
servers as the user connects to each server.

CAUTION: The Enterprise Services server creates the users and 
passwords on the Essbase servers but it does not replicate the access 
privileges of the users. 

Additional steps are required to complete this replication of users. You must 
manually create the privileges for the users on each of the Essbase servers. Once 
these privileges have been created, you must continue to maintain them. Essbase 
Enterprise Services does not synchronize the privileges of users across the Essbase 
servers.

Fault Tolerance
There are two levels of fault tolerance in Essbase Enterprise Services.

Fault Tolerance in the Java API
If EES stops (normally or abnormally) and is restarted while a Java API client 
session is already in progress, the Java API will automatically restore the session. 
This feature is currently not supported for outline operations and cube view 
operations, and is supported for all the rest of the functionality. 

Fault Tolerance in Essbase Enterprise Services

Case 1: 
To get Enterprise Services to reconnect and retry data query operations (read-only) 
on the same OLAP server, perform the following steps. 

Enterprise Services needs to be configured with connection pooling (in connection 
per operation mode or connection per session mode) over a cluster or over a 
component (cube). 

The Java API client performing data query using openCubeView, make sure that 
the last four parameters are True.  
6
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IEssDomain.openCubeView(String cubeViewName, 
                        String olapSvrName,
                        String appName, 
                        String cubeName,
                        boolean useConnPool,
                        boolean connPerOp,
                        boolean useCluster,
                        boolean readOnly)

In addition, make sure connection pool is configured for the specified appName 
and cubeName. 

The following Essbase error conditions can be recovered: 

� User logged out by Supervisor (1013095 ). 

� Essbase agent restarted (1042006 ). 

� Invalid login id (1013136). 

� Logged out due to inactivity (1051021 ). 

� System is temporarily busy (1051010 ). 

� Client timed out to receive data via tcp (1042017). 

� Cannot receive data (1042013). 

Several external conditions can also be recovered. Many conditions can be 
identified in the Essbase.Properties file before the condition occurs.  Specify the  
following in the Essbase.Properties file before starting the EES server:  

                            
system.faultTolerance.reconnectRetryOnSameSvcComp.onErrorCodes=
1013095,1042006,1013136,1051021,1051010,1042017,1042013

If you encounter error codes other than those specified in the condition above, add 
those to the comma-separated list in the above Essbase.Properties entry. 

Example usage scenario: 

1. Create a cluster (for example, demobasiccluster) with 2 identical components 
(localhost/demo/basic, localhost/demo2/basic) 

2. Create a connection pool (for example,demobasicpool) using this cluster 
(demobasiccluster),  and set  initial connections as 4, maximum connections 
as 4, and connection increment as 0. 

3. Enable this cluster and connection pool to be hosted by EES server. 
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4. Start the OLAP servers and the EES server. 

5. Start the clients that use Java API data query operations over the connection 
pool. 

6. See that the requests are equally distributed between demo/basic and 
demo2/basic. 

7. Logout the connection pool user from the OLAP server using the Essbase 
Application Manager. 

8. Continue running clients using the Jave API data query operations. 

9. See that the EES server automatically reestablishes the connection on the 
same OLAP server, without interrupting the clients. 

Case 2:
To get Enterprise Services to retry (without reconnecting) data query operations 
(read-only) on the same OLAP server, perform the following steps. 

1. Enterprise Services needs to be configured with connection pooling (in 
connection per operation mode or connection per session mode) over a cluster 
or over a component (cube). 

2. Specify the following in the Essbase.Properties file, along with proper error 
codes separated by comma, before starting the EES server:  

system.faultTolerance.retryOnSameSvcComp.onErrorCodes= 

Case 3:
To get Enterprise Services to retry data query operations (read-only) on different 
OLAP server in the cluster, perform the following steps. 

Enterprise Services needs to be configured with connection pool (in connection 
per operation mode) over a cluster. In addition, make sure connection pool over 
cluster is configured with at least one component matching the specified appName 
and cubeName. 

The Java API client performing a data query using openCubeView needs to make 
sure that the last four paramenters are True. 

IEssDomain.openCubeView(String cubeViewName, 
                        String olapSvrName, 
                        String appName, 
                        String cubeName, 
6
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                        boolean useConnPool, 
                        boolean connPerOp, 
                        boolean useCluster, 
                        boolean readOnly) 

The following error conditions can be recovered :

� Disabled user commands (1013009, 1013204, 1054009, 1054010) 

� Active database stopped by supervisor (1013110) 

Several external conditions can also be recovered. Many conditions can be 
identified in the Essbase.Properties file before the condition occurs.  Specify the  
following in the Essbase.Properties file before starting the EES server:  

system.faultTolerance.retryOnNextSvcComp.onErrorCodes= 
1013009,1013204,1054009,1054010,1013110 

If you encounter error codes other than those specified in the condition above, add 
those to the comma-separated list in the Essbase.Properties entry.       

Example usage scenario: 

1. Create a cluster (for example, demobasiccluster) with 2 identical components 
(localhost/demo/basic, localhost/demo2/basic) 

2. Create a connection pool (for example, demobasicpool) using this cluster 
(demobasiccluster), and set initial connections as 4, maximum connections as 
4, and connection increment as 0. 

3. Enable this cluster and connection pool to be hosted by EES server. 

4. Start the OLAP servers and the EES server. 

5. Start the clients that use the Java API data query operations over the 
connection pool. 

6. See that the requests are equally distributed between demo/basic and 
demo2/basic. 

7. Disable commands on demo application using the Essbase Application 
Manager or the Enterprise Services Console. The reason to disable commands 
on an application is to perform operations such as data load. 

8. See that the requests now only go to localhost/demo2/basic, as EES detects the 
error and re-routes the request to the next component in the cluster 
(localhost/demo2/basic) 

9. Enable commands on demo application. 
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10. See that the requests are equally distributed between demo/basic and 
demo2/basic. 
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Chapter
7

Essbase Enterprise Ser
Advanced Installation Topics
This chapter describes advanced installation procedures for Essbase Enterprise 
Services, provides a list of locations for commonly needed files, lists the 
commands for Essbase Enterprise Services Command Shell, and provides 
instructions for uninstalling the product.

This chapter contains the following topics:

� “Manually Installing Java” on page 85

� “Creating Pointer Files to Essbase.properties” on page 87

� “Essbase Enterprise Services File Locations” on page 88

� “Command Shell Commands” on page 89

� “Uninstalling Essbase Enterprise Services” on page 90

Manually Installing Java
Essbase Enterprise Services requires the Java Runtime Environment (JRE) to run 
the Essbase Enterprise Services server. On UNIX systems, the JRE must be 
installed to run the Essbase Enterprise Services installation.

Note: On UNIX systems, you may need to install operating system patches 
to support the JRE. For more information, see “Installing the JRE on 
UNIX Systems” on page 86.

If you have already installed a supported version of the Java Runtime 
Environment, you do not have to reinstall the JRE. However, you must verify that 
the necessary PATH environment variables are set.

For more information about supported versions of the JRE, see “Windows System 
Requirements” on page 28 or “Solaris System Requirements” on page 36. 
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Installing the Java Runtime Environment
The Java Runtime Environment is required by Essbase Enterprise Services to run 
the server software. The setup program automatically installs the JRE if you 
choose this option. Alternatively, you can install the JRE separately before 
installing Essbase Enterprise Services and use the existing installation of the JRE. 
For more information about using an existing installation of the JRE, see 
“Installing Essbase Enterprise Services on Windows Systems” on page 28 or 
“Installing Essbase Enterprise Services on UNIX Systems” on page 36.

Installing the JRE on Windows Systems
The Java Runtime Environment installation package for Windows systems is a 
self-installing executable that walks you through the installation of the JRE. 

➤ To install the Java Runtime Environment on Windows systems:

1. If necessary, download the installation package from the appropriate Web site. 
Web site locations are listed in the readme.txt file located in the Essbase 
Enterprise Services docs directory.

2. Change to the directory containing the downloaded JRE installer for Windows 
systems:

3. Run the .exe file in the directory.

4. Follow the on-screen installation instructions to complete the installation of 
the JRE.

Installing the JRE on UNIX Systems
The Java Runtime Environment installation packages and installation procedures 
for each of the supported platforms are substantially different. Installation 
instructions from the JRE providers are provided at the Web sites where you 
download the package. Review these instructions carefully.

➤ To install the Java Runtime Environment on UNIX systems:

1. Log on as the Essbase Enterprise Services system administrator account. For 
example, log on as admin if you created a user account called admin that 
owns the target installation directory, 
/home/hyperion/essbase/essenterprise.
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2. If necessary, download the installation package from the appropriate Web site. 
Web site locations are listed in the readme.txt file located in the Essbase 
Enterprise Services docs directory. 

3. At the JRE download Web site, review and print the installation instructions 
for the install package. You will need to refer to these instructions when you 
install the JRE.

4. Change to the directory containing the downloaded JRE install package for the 
operating system:

5. Follow the instructions you printed in Step 3. In most cases you must execute 
an installation program or decompress a file to install the JRE.

Note: Use of the JRE requires operating system patches on some 
platforms. Review the installation instructions for the JRE for 
patch requirements and verify that you have installed the correct 
patch level to support the JRE you are installing.

6. Set any environment variables specified by the installation instructions for the 
JRE you have installed.

Creating Pointer Files to Essbase.properties
When you set up Essbase Enterprise Services to run as servlet or EJB in a Java 
application server or Web server, you must provide the Enterprise Services server 
with access to an essbase.properties file. The usual way to handle this 
requirement is to copy the essbase.properties file into a directory of the Java 
application server or Web server. However, you can avoid having duplicate copies 
of this file by creating essbase.properties files that act as pointers to a central 
essbase.properties file. By creating files that point to a central 
essbase.properties file, you can have a single essbase.properties file 
for all Essbase Enterprise Services servers. This technique simplifies the 
administration of Essbase Enterprise Services by minimizing the number of 
essbase.properties files you have to manage.

Note: A pointer file cannot point to another pointer file.

➤ To create a pointer file to another essbase.properties file:

1. In a text editor, start a new file called essbase.properties.

2. Type the following text into the file:
7
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# pointer file to essbase.properties
system.props.file=C:/hyperion/ess/bin/essbase.properties

The above example shows the default location for the 
essbase.properties file. Modify the path to this file to fit your computer 
environment.

3. Save the essbase.properties file in directory of the Java application 
server where you would normally put the full essbase.properties file. 

For more information on where this file should be located, see “Essbase 
Enterprise Services File Locations” on page 88 or “Configuring Servers to 
Use TCP/IP, HTTP, EJB, or CORBA” on page 46.

Essbase Enterprise Services File Locations
Installation and configuration of the Essbase Enterprise Services software and 
other component software can lead to a complex array of files. After configuring 
an Essbase Enterprise Services server, you can use Table 3 to help find the files 
that start a server and control its configuration.

Table 3 lists the default locations and names of the scripts that are needed to start 
Essbase Enterprise Services servers of specific types. The table also lists the 
location of the essbase.properties file, which controls the configuration of 
the Essbase Enterprise Services server.

Table 3: Default Locations of Start Scripts and essbase.properties File

Server Type Server Start Script essbase.properties file

TCP/IP c:\hyperion\essbase\essenterprise\bin\
startees.cmd

c:\hyperion\essbase\essenterprise
\bin\

HTTP/WebLogic c:\weblogic\
startWebLogic.cmd

c:\weblogic\

HTTP/Jigsaw c:\program files\jigsaw\scripts\
jigsaw.bat

c:\program files\jigsaw\scripts\

EJB/WebLogic c:\weblogic\
startWebLogic.cmd

c:\weblogic\

CORBA/VisiBroker c:\hyperion\essbase\essenterprise\bin\
startees.cmd

c:\hyperion\essbase\essenterprise
\bin\
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Command Shell Commands
Essbase Enterprise Services has a command line interface component called the 
Command Shell. When you start the Essbase Enterprise Services server as a 
stand-alone application—using the startees.cmd file—the Command Shell is 
displayed. Use this console to perform high-level server operations. Pressing the 
Enter key in the server window displays the Command Shell prompt. Typing help 
and pressing Enter provides a list of all available commands.

You can start the Command Shell as a program separate from the Essbase 
Enterprise Services server. For information about starting the Command Shell as 
a separate program, see “Starting and Stopping the Enterprise Services Command 
Shell” on page 66.

You can use the following commands in the Command Shell:

Table 4: Command Shell Commands 

Commands Description

quit/exit Shuts down the Command Shell

If this command is issued from within the Essbase 
Enterprise Services server window, the server is also 
shut down.

help Lists all Command Shell commands and their functions

runningeesservers Lists all the currently running Essbase Enterprise 
Services servers

signon Logs on to an Essbase Enterprise Services domain

signoff Logs off of an Essbase Enterprise Services domain

apiver Displays the Essbase JAPI version number

apiverdetail Displays the Essbase JAPI version number, client 
version number, and compatibility information

adduser Adds a user to the root domain

changepwd Changes the password for a user

listusers Displays a list of all users that are registered in the root 
domain of the Essbase Enterprise Services server

removeuser Removes a user from the root domain
7
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Uninstalling Essbase Enterprise Services
You can uninstall Essbase Enterprise Services from Windows systems and UNIX 
systems. This section shows you how to uninstall Essbase Enterprise Services 
software from your computer or from a network drive.

Instructions for Uninstalling from Windows Systems
To uninstall Essbase Enterprise Services, use the Windows Add/Remove 
Programs icon in the Control Panel.

➤ To uninstall Essbase Enterprise Services from Windows NT 4.0 and Windows 
2000:

1. Select Start > Settings > Control Panel > Add/Remove Programs.

2. Complete the following step that is appropriate for your operating system:

� On Windows NT 4.0:

On the Install/Uninstall tab, select the Essbase Enterprise Services 
software you want to remove, and click Add/Remove.

� On Windows 2000:

Select Change/Remove Programs, select the Essbase Enterprise 
Services software you want to remove, and click Change/Remove.

3. Click Yes to confirm that you want to remove the program.

addolapserver Adds a Essbase server to the root domain

listolapservers Lists the Essbase servers in the root domain

removeolapserver Removes an Essbase server from the root domain

setprompt Sets the prompt text for the Command Shell

synccubereplicas Synchronizes data among replicas of a Essbase 
application

syncsectoees Synchronizes security information from a Essbase 
server to the Essbase Enterprise Services server

Table 4: Command Shell Commands (Continued)

Commands Description
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4. If a Remove Shared File? prompt appears, click Yes To All.

Windows removes the program and associated files. If some elements of the 
program could not be removed, click Details for more information.

5. Click OK.

Instructions for Uninstalling from UNIX Systems
To uninstall Essbase Enterprise Services, use the uninstaller program created by 
the Essbase Enterprise Services setup program. The uninstaller program requires 
a supported version of the Java Runtime Environment to be in the path.

➤ To uninstall Essbase Enterprise Services from UNIX systems:

1. Log on to the computer where Essbase Enterprise Services using the same user 
account that installed the software.

2. Move to the ESS_ES_HOME/UninstallerData/ directory.

3. Execute the UninstallEES file; for example, at the command prompt, type 
the following command:

>./UninstallEES

The uninstaller program removes the program and associated files.
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Glossary
accounts. A list of users and groups that determine access to a domain in 
Hyperion Essbase Enterprise Services.

Application Programming Interface (API). A library of functions that you can 
use in a custom program. Essbase Enterprise Services provides a Java API that you 
can use to develop client programs.

applet. In Java, a program that can run in a Web browser. Small programs written 
in languages other than Java are sometimes referred to as applets.

application server. A Java software server that runs Enterprise Java Bean (EJB) 
programs, Java servlets, Java Server Pages (JSPs) and provides infrastructure for 
large-scale Java programs, such as connection pooling, session pooling, 
multithreading and load balancing.

cluster. A group of Essbase Enterprise Services or Essbase servers to act as a 
single server to share task loads and provide failover support. Clustering 
eliminates Essbase servers as a single point of failure in a system.

connection pooling. A collection of user logins to Essbase servers. Pooling of 
user connections facilitates the scaling of Essbase applications to thousands of 
users.

Common Object Request Broker Architecture (CORBA). A distributed 
software-to-software communication specification which enables remote 
procedure calls from one software program to another on the same computer or 
across a network.

cube. A representation of an Essbase multidimensional database.

domain. A logical grouping of administrative objects, such as users, groups, and 
servers.

Enterprise JavaBean (EJB). Server side framework and programming 
architecture for creating distributed java applications.
� 93Essbase Enterprise Services Installation Guide



ig_eds.book  Page 94  Thursday, June 20, 2002  8:20 PM
Enterprise Services server. A server running the Essbase Enterprise Services 
software that manages requests between the client and OLAP servers, in addition 
to providing various services, such as event handling and authentication.

Essbase JAPI. Object-oriented application programming interface, enabling 
programmers to create custom Java applications for Essbase and Essbase 
Enterprise Services. 

failover support. Automatic detection of service interruption due to Essbase 
server failure. When failure occurs, Essbase Enterprise Services dynamically 
routes server requests to the next Essbase database in the cluster.

group. A list of Essbase users. A user can belong to more than one group.

Hypertext Transfer Protocol (HTTP). A widely supported communication 
protocol used by Web browsers, Web servers, and other software programs to 
communicate over the Internet.

Internet Inter-ORB Protocol (IIOP). The communication protocol used to 
communicate between CORBA ORBs over TCP/IP.

JAPI. Java Application Programming Interface.

J2EE (Java 2, Enterprise Edition). A specification for Java technology, 
including the Java programming language, Java application servers and related 
technology.

load balancing. Distribution of requests across a group of Essbase servers, which 
ensures optimal end user performance.

OLAP server. A server running multidimensional databases, such as Essbase.

Object Request Broker (ORB). Technology that enables clients to 
communicate with servers via an object bus.

RAID (redundant array of independent [or inexpensive] disks). A persistent 
storage system that provides convenient, low-cost, and highly reliable storage by 
saving data on more than one disk simultaneously. 

Relational Database Management Systems (RDBMS). A type of database 
management system that stores data in the form of related tables.

Remote Method Invocation (RMI). A programmatic remote access 
communication protocol for communication between Java programs. This 
protocol is typically used in communication between EJBs running on application 
servers.
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replication. In Essbase Enterprise Services, the copying of data from one Essbase 
application database to another.

single sign-on. Ability to log into an Essbase Enterprise Services domain only 
once and, based on access rights, access resources.

Service Provider Interface (SPI). A technology enabling new services to be 
added to Essbase Enterprise Services.

Servlet. An small application (applet) that runs on the server rather than the client 
in a client/server system.
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Server Clusters, 60
server management, 75
server, EES, 16
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shell, 89
startees script, 89
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